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Chapter 1 
 

Introduction 
 
Bill of Materials is an application designed for companies that manufacture or assemble products 
for customers and for stock.  However, different companies will have widely differing 
requirements, and the application is therefore highly user-configurable whilst retaining simplicity 
of use. 
 
When companies stock, not only completed products, but also the components which are used to 
make these completed products then Bill of Materials allows for the generation of works orders to 
document this manufacturing/assembly process.  For example, a jam manufacturer needs to stock 
all the jam making ingredients as well as empty bottles, labels, bottle tops and packing cases – 
Bill of Materials is designed to handle the stock movements which occur when components are 
used to make complete products. 
 
Bill of Materials is based on Stock Control’s assembly procedures, so you may want to read the 
relevant section of the stock manual.   
 
Outline 
 
The Bill of Materials system maintains the works orders needed to describe the building of 
complete products.  A works order can either be based on the structure of an existing stock 
assembly, as when making a product for stock, or can be designed from scratch – as might be the 
case for a customer-specific order.  As the works order is created the components are reserved to 
the works order, and the finished item is placed on-order.  Where a component item is an 
assembly itself, sometimes termed a sub-assembly, then the system can explode the components 
of this assembly as well – supporting up to ten levels of assembly. 
 
The details of a works order can be printed – with a fully user-definable document in the standard 
Datafile way.  When ready to build you can print a picking list to help with assembling the 
components needed for this build. 
 
Once the product is built, and the works order is complete, the system will then remove from 
stock item items used in the build process (reducing the reserved quantity), and put into stock the 
completed item(s).  The Bill of Materials program integrates fully with the Datafile Stock Control 
and Batch Tracking systems.  It also allows for stock wastage where you lose a percentage of a 
component in the build process, for example, loss of liquids due to evaporation. 
 
Information about works orders is held in two files – the Works Order Header file holds the 
information about the order as a whole, the Works Order Detail file holds information about the 
individual entries that make up the Bill of Materials.  You can also include details of process and 
labour costs as items in the detail file to enable you to derive an actual cost for the item.   
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Principal Features 
 
 
 Works Orders entered based on assembly definition or free-format 
 
 Up to 10 levels of sub-assembly components supported 
 
 Automatic expansion of sub-assembly components, based on qty required or qty needed 
 
 Include Build/Picking Instructions within Works Order 
 
 Generate Works Orders from Sales Orders 
 
 Support for Stock Wastage 
 
 Quantities to 2 or 4 decimal places 
 
 Costs to 2 or 4 decimal places 
 
 Comprehensive picking note and reporting options 
 
 Record Work-in-Progress quantities on stock (BOM Reserved / BOM On-Order) 
 
 User Definable Works Order Header and Detail entry screens and databases 
 
 User Definable Works Order reports 
 

Stock Assemblies 
 
Bill of Materials is primarily based around the Stock Control ‘Assemblies’ option, where you are 
normally taking the assembly structure for the basis of creating a works order.   
 
An assembly is a stock item in its own right.  You can record sales issues, receipts, transfers and 
adjustments as you can with a ‘normal’ stock item.  You can see physical stockholding, quantities 
reserved and on-order.  However, when stock levels are low rather than ordering the item from a 
supplier you will build the item yourself. 
 
Here is an example of an assembly – taking as an example the PC on your desk. 
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When you come to make a PC for stock then you will use up components from which it is made – 
each PC contains a monitor, keyboard, system (box), mouse, etc.  As seen in the diagram above 
the ‘system box’ is also an assembly, or sub-assembly, containing its component parts. 
 
Assembly and Component Files 
 
Separate databases hold details of each product that is defined as an assembly – the Assembly file 
holds the list of assembled products, the Component file holds the list of items used in building 
the assemblies.   
 
Each Assembly is referenced by an assembly ‘code’ – this code could either be the same code as 
that used for the finished stock item or another code of your own requirements.  The same 
components may be needed on a number of differing assemblies and a component may be a stock 
item which is itself an assembly.  Each assembly is defined as a single-tier, if a component is also 
an assembly item, usually termed a sub-assembly, then you enter the component requirements as 
per other items and then create a separate assembly definition for the sub-assembly. 
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Stock Control itself does allow options to build the assembly, the advantages Bill of Materials 
provides over Stock are that BOM allows greater flexibility in amending and reporting the build 
requirements.  For more details on the stock assembly maintenance see the relevant section of the 
stock control manual. 
 

1. Enter  Stock 
Item and 
Quantity the 
assembly is to 
build.  Cost 
Price displayed 
is the 
accumulated 
cost of the 

2.  Enter Component Details.  Select Type of Entry —
S=Stock, N=Build Note, C=Comment.  For Stock Items 
enter the component stock code and quantity, for build 
notes and comments enter the instructions required. 
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Chapter 2 
 

User Instructions 
 
This chapter describes how to use the Datafile Software Bill of Materials system.  We assume you 
have already learned how to sign on to your Datafile Software system and how to use the Datafile 
DeskTop facilities – these topics are covered in full in the Systems User Guide.  Your Bill of 
Materials application will be one of the applications on the main menu; on selecting this menu the 
options available for Bill of Materials will be displayed. 
 

 
 

Application Menu Parameters 
 
Each menu option has a four digit parameter number.  This number is the parameter 
which is needed for users who wish to restructure their applications, or defined new 
menus.  For example to add a new works order the parameter is “1001”.  These 
parameters are only needed under the CONFIG user to change or define application 
menu structures – see the System User Guide for more details. 
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Choosing the Right Company 
 
You can use Bill of Materials for more than one company’s data.  Where you have more than one 
company, then if the computer does not know which company’s data to process, it asks you to 
select one from a list.  This can occur if the computer has not previously processed any company 
in this session, or if the last company it processed does not have Bill of Materials defined for it. 
 

 
The active company is displayed in the status line at the bottom of the screen.  You can change 
the company (provided you are within the menu system and not in a specific option) by using the 
‘Datafile / Open New Company’ option on the Datafile DeskTop. 
 
General Notes 
 
Throughout Datafile Software there is syntax to the keyboard keys, and conventions to the way 
screens and messages are displayed.  These are described in the System Users Guide supplied 
with your system, but in summary: 
 
 In the text below, chevrons <> around words or letters tells you to press that key on the 

keyboard.  For example, <End> means the key which has the word “End” on it; and <F1> 
refers to the first of the ten (at least) keys along the top of, or to the left of, the keyboard 
with the inscriptions “F1” through “F10” on them. 
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 <Enter> means the (carriage) return key or “Enter” key on the keyboard, used to signify 
that all the data for a field (the highlighted area on the screen in which key strokes appear 
as you type) is now ready to be processed by the computer.  Although the text specifies 
<Enter> to input information, there may be parts of the program where the use of the 
<Enter> key is not required because of the way the system has been configured.   

 
 <Escape> is the key marked “Escape” or “Esc”, and is used to exit from whatever you 

were doing — often you are asked if you have finished, to prevent accidents. 
 
 The Select function is assigned to the <F4> key.  This gives a powerful way to find an 

account or stock code, either through a part of the code, or part of the account name / stock 
description, or even part of some other field such as a contact or telephone number. 

 
 The status line of the screen displays the major function keys available at any point.  This 

doesn’t though include the <F10–DeskTop> key which accesses the Datafile DeskTop and 
is available at any point. 

 
 The <F8–Zoom> facility is one of these DeskTop facilities, and, when it is shown, this 

allows you to go straight into the Ledger Enquiry facilities to enquire the ledger details for 
the specific account, stock or product on which you are working. 

 
 The <F9–Memo> facility is another such DeskTop facility, which allows you to attach a 

free-format memorandum to the account, stock or product you are currently working on for 
display at any subsequent time you work on or look at this record. 

 
There are many optional features in the Bill of Materials application, and it is possible that not all 
are in use in your system.  If your configuration does not include any specific features then you 
need not take any notice of the instructions which apply to them. 
 

Enter Works Orders 
 
Orders consists of two parts, an order header for the item being build, and order details for the 
components being issued and build instructions – you can enter up to 500 details per order.  When 
selecting the option to ‘Enter Works Orders’ the order header entry screen is displayed with 
options to maintain the works orders. 
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Adding a Works Order 
 
When adding a works order some preliminary information is entered before you enter the general 
works order information. 
 
Assembly No? 
Stock Code? 
 
The first input asks for the assembly number – you enter the required assembly number, using 
<F4-Select> to search if necessary.   
 
Alternatively, if you want to enter a free-form works order to build a stock item then you can use 
the <F5> key to swap between asking for the stock code or the assembly you wish to build.  At 
the point of entering the stock code <F4-Select> is again available to search for the stock code.  In 
addition, the <F7-Option> key can be used to create a new stock record. 
 
Quantity 
 
Here you are asked for the quantity you wish to build on the finished item.  Only positive values 
are accepted – if you wish to breakdown or de-kit an assembly into its component parts you 
would enter a positive value but flag the works order as a ‘credit’.   
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On input of the order quantity you may be warned that the quantity is ‘Not a Multiple of 
Assembled Quantity’.  On definition of an assembly the quantity of finished item that the 
components build is usually ‘1’, however economies of scale may mean it is better to build more 
than one of the finished item.  Works Order entry will validate that the entered build quantity is an 
exact multiple of the assembly build quantity and warn when appropriate – <F7-Option> is 
available to override the warning and build the entered amount. 
 
Order Ref 
 
You are asked to confirm the works order reference.  This is usually generated for you on a 
sequential basis – confirm or enter as appropriate. 
 
After confirming the order reference you are then ready to enter the general works order 
information.  An example screen is shown below, remember these screens can be amended to 
reflect the information you wish to enter in the works order header. 
 

 
Order Reference 
 
Displays the order reference for the works order. 
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Date Entered 
 
Displays the current system date, you can overtype if required.  Note that if set to generating 
reserved/on-order transactions to Stock Control, then the system will warn on confirmation of this 
date if it is outside the current stock period. 
 
Date Required 
 
Enter the date build of the works order is required by. 
 
Assembly Code 
Stock Code 
Order Quantity 
 
These items are view-only and display the details entered during the initial stage of works order 
entry. 
 
Stock Description 
 
Description used on stock transactions generated from this works order. 
 
Sales Account Code 
 
If build is for a specific customer enter the customer account code here.  <F4-Select> is available. 
 
Customer Reference 
 
Enter the customer reference, if any, for this works order. 
 
Extra Text 
 
Enter any extra build instructions required. 
 
Finished Item is Batch/Serial Tracked? 
 
Once you have completed the header details you may, if the finished item is batch or serial 
tracked, be asked to enter the batch/serial codes of the item being built when the Bill of Materials 
system is configured for pre-allocation of batch/serial numbers.  A pop-up will ask for the batch 
details being built, the batch codes being built will normally have a system generated number but 
you can enter/scan the codes as required. 
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You can prompt for up to five extra items to be recorded against the batch record.  For example, if 
building perishable items you may want to enter an expiry date. 
 
On completion of input of batch/serial codes the system will create the batch records against the 
finished item and mark the records as on-order.  Note that it isn’t mandatory to enter the batch 
details as no physical movement has yet taken place. 
 
Auto-Generate Component Details 
 
If the works order has been entered for an assembly item then the system will, on completion of 
the header details, generate works order details for the components of the assembly.   
 
Where a component item has insufficient stock available an on-screen warning is given.  This 
warning shows the quantity required (or build quantity), the free stock level and the calculated 
shortfall.  You can then take remedial action, either placing a purchase order or substituting the 
component with an alternate item.   
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Where a component is a batch/serial tracked item then you may, if configured for pre-allocation, 
be prompted for the batch/serials to be reserved against the works order.  These may be suggested 
for you on a FIFO or user-defined sequence, or you can scan/key the batch numbers required.  
<F4-Select> is available to show the active batch numbers. 
 
After displaying any out-of-stock warnings and prompting for pre-allocated serials the detail entry 
options are displayed. 
 
Works Order Detail Entry 
 
The initial order detail display screen is split into three sections – header, detail and footer.  The 
header shows the main information regarding the works order – the order reference, the total cost, 
the number of detail lines and the stock item being built.  The detail shows the component lines 
already generated and the footer shows the options available. 
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Details 
 
On selecting DETAILS you are taken into the component detail entry.  A scroll bar highlights the 
active record and you can move the bar up/down to highlight the entry you wish to amend or the 
position at which you wish to insert an entry.  <Enter> or a click with the mouse opens the 
highlighted detail for amendment, to insert a new line press <F5-Insert>.  <F6-Delete> can be 
used to remove an entry. 
 
The typical details input include the Stock Code, Description and Quantity.  Cost Price and Level 
Number may additionally be displayed but are often set to be treated as view-only, although cost 
can be input if desired.  On input of description a ‘pop-up’ form allows entry of the description 
and extra text allowing, by default, up to ten lines of text. 
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Again, for manual input of lines then where a component is a batch/serial tracked item then you 
may, if configured for pre-allocation, be prompted for the batch/serials to be reserved against the 
works order.  These may be suggested for you on a FIFO or user-defined sequence, or you can 
scan/key the batch numbers required.  <F4-Select> is available to show the active batch numbers. 
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Once all required detail input is completed you can press the <ESC> key or the X-close button of 
the detail entry screen to return to footer options. 
 

 
Sub Assembly Components 

 
If a works order detail is entered, either manually or as part of the initial auto-
generation of details, for a stock item that is an assembly then the components of 
that sub-assembly will be automatically inserted as well – subject to configuration.   
 
Bill of Materials configuration allows three options for the explosion of sub-
assemblies – expand always, expand never and expand on insufficient stock. 
 
If the system is set to expand always then the sub-assembly components (and any 
further sub-assemblies off this) are automatically generated for the full build 
requirement.  If set to never expand then the sub-assembly component detail is 
added but is not exploded – the assumption being you would enter another works 
order for this item (perhaps to build extra for stock). 
 
If the system is set to expand only on insufficient stock then the system issues any 
available stock and explodes the components only for the shortfall 
 
If you increase the quantity then the quantities of the sub-assembly components are 
inflated as appropriate, if you reduce the quantity then the components have to be 
manually adjusted.  If you delete a sub-assembly then the components are deleted 
for you. 
 

 
Print 
 

The PRINT option allows you to print a works order 
acknowledgement or build note.  On selection of the option 
you are asked to choose whether you wish to use the ‘PRINT-
ORDER’ (the acknowledgement) or ‘BUILD-ORDER’ 
documents – you are then asked to confirm the document date 

and the printer the document is to be sent to.  By default the documents are processed 
automatically – for details on the print procedures when processing the document manually see 
the relevant sections for the ‘Works Order Acknowledgement’ and ‘Build Note’. 
 
TEXT 
 
The TEXT option allows you input or amend the ‘Additional Notes’ for the works order that may 
have previously been entered when adding the Works Order.   
 
<F5-Insert> and <F6-Delete> are available to insert and delete lines as appropriate. 
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Header 
 
The HEADER option allows you back into the works order header maintenance to add to or 
amend any details previously entered.  This screen may, optionally, be different from the initial 
entry screen as the HEADER option uses the ‘update’ works order screen rather than the 'add' 
screen which allows for different configuration. 
 

 
Alternate Component Detail Input Methods 

 
The above is the default configuration for order detail entry – and in practice is the 
only applicable configuration when including sub-assembly details and requiring 
the ability to insert new details within the works order.  An alternative 
configuration replaces DETAILS with separate options for ADD, CHANGE, 
DELETE, FAST and LIST 
 
ADD and CHANGE both display the full screen order detail input (the same screen 
as available on <Page-Down> from stock code input in DETAILS.  DELETE 
replaces <F6> to delete a line from within DETAILS.  FAST allows the quick 
addition of detail lines and LIST displays the order details for the works order. 
 

 

Updating a Works Order 
 
The UPDATE action allows you to amend or add to the works order header information 
previously entered.  On selection of UPDATE you are asked for the order reference to update, key 
in the appropriate number or use <F4-Select> to search.    By default the items displayed are 
primarily the same as when the order was added, however the ADD and UPDATE screens are 
separately definable so may be different. 

Changing Order Details 
 
The DETAILS action allows you to amend or add to the details previously entered.  On selection 
of DETAILS you are asked for the order reference to update, key in the appropriate number or use 
<F4-Select> to search.  The same actions as discussed in the ADD process are available. 

View an Order 
 
The VIEW action displays the order header details.  On selection you asked for the order 
reference to update, key in or use <F4-Select> to search.  The screen displayed on VIEW action is 
as per the UPDATE screen. 
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Changing the Order Status 
 
When you add an order it is set automatically as an ‘A-Active’ order, when the order is built its 
status is automatically updated to ‘C-Complete’.   
 

 
This option allows you to manually change the status of an order – the available status codes are: 
 
A-Active Details are waiting to be built.  Active orders can be change to any of the other 

status codes.  If changed to ‘C-Completed’, ‘D-Deleted’ or ‘F-Forward’ then 
stock reserved and on-order quantities will be updated to reflect the change in 
status. 

 
C-Completed Order has been fully built.  You can manually change any status to ‘C-

Completed’ (except D-Deleted) to indicate no further processing required – 
stock is unreserved and taken off order were appropriate. 

 
D-Deleted This option marks the status as ‘D-Deleted’ but doesn’t remove the order from 

the file (as in the DELETE action).  This allows it to remain as a ‘placeholder’ 
for later enquiry.   

 
H-Hold This status prevents an order being built but doesn’t release the stock 

reservations.  You may mark an order as on hold whilst waiting for delivery of a 
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component, or where the works order is for a customer and you place on hold 
for credit reasons.  Only active orders can be placed on hold. 

 
F-Forward This status prevents an order being built but doesn’t reserve stock, although you 

can record as ‘forward’ reserved on stock.  Only active orders can be marked as 
forward. 

 
On first selection of the STATUS routine you are asked whether to display the orders in the 
sequence entered 

 
The usual response here is ‘NO’.  If you respond ‘YES’ then all orders are displayed one-by-one 
allowing you to amend the status if required, if you have a large number of orders on the system 
this could be time consuming. 
 
If you do respond ‘NO’ then you are asked for the order reference to change (F4-Select available), 
the system the displays the finished stock item, the cost value, the date entered and the current 
status.  This status can then be changed as required. 

Deleting an Order 
 
The DELETE option removes the works order header and detail records from the database, 
releasing the reserved/on-order quantities as appropriate. 

Generating Works Orders from Sales Orders 
 
On sales order detail entry a flag can be set when adding an order for an assembled stock item to 
create a works order, the GENERATE option reads these details and creates works orders for 
them. 
 

 
When you select the GENERATE option you are asked to enter a sales order reference range 
and/or a sales order date range – either leave blank to process all active orders or enter an 
appropriate range to restrict the orders generated.  In addition to criteria for the order reference / 
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date you can specify selection criteria against the sales order detail database to further restrict the 
details processed. 
 
Once you’ve set the appropriate criteria the system generates the works orders as appropriate – 
one per flagged sales order detail – and produces an audit trail report showing the sales order 
processed and the works orders generated. 
 

Print/Build Works Order 
 
The Works Order Acknowledgements are used as instruction documents for those picking the 
components and building the finished goods.  Information can be printed from the stock file as 
well as the works order files.  The Build Notes operate in the same general manner as the Works 
Order Acknowledgement but updates the stock details for the build at the end of the process. 

Select Document Layout 

 
Up to six different documents may be configured for the acknowledgement or build documents – 
for acknowledgements, one document could be used for stock picking, another containing the 
build instructions etc.  For build notes you may have a de-kit (credit) document in addition to the 
build note.  On selection of the ‘Print/Build Works Order’ option if more than one document is 
available a list is displayed, otherwise if only one document is configured then this is 
automatically selected for you. 
 
After selecting the document you may be asked for the printer to send the document to, this can 
also be asked at the point of printing the document depending on document configuration. 

Header Information 

 
Order Ref 
 
After selecting the document layout you are asked for the works order reference you wish to 
process.  <F4-Select> is available to search if required.   
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Date 
 
Defaults to the ‘system’ date although may be overtyped (which is then remembered as the 
system date for next process).  This date will be validated according to the current stock period 
and some warnings may be displayed when outside this date range. 
 

 
If this message is displayed then the date entered is more than one period in advance of the 
current stock period and thus not allowed.  Press <Enter> and re-enter date within the current 
period. 

 
If this message is displayed then the date entered is in the next stock period.  Select whether you 
wish to post to this date or not.  Note the effect on quantity of forward transactions would not be 
included (by default) in the stock valuation report. 

 
If this message is displayed then the date entered is earlier than the current stock period.  Select 
whether you wish to post to this date or not.  Note other than the date of the transaction itself 
posting to a previous period has no affect – demand etc. is updated for the current period. 
 
Document Number 
 
Displays the next in the incremental number sequence for this document and, by default, cannot 
be overwritten. 
 
Stock Code 
 
Displays the stock code being built (view-only). 
 
Quantity 
 
Asks for the quantity the works order print is to be processed for – usually defaulting to the 
outstanding to be built.  Note – on the build document if the assembled stock item is serial/batch 
tracked and one or more of the components are serial/batch tracked then you cannot build more 
than one batch/serial at a time to maintain traceability. 
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Batch Codes 
 
If the finished item is batch/serial tracked then you will be prompted, on a build document, for the 
batches to be built.  Note that if any component is batch/serial tracked and the finished item is 
also batch/serial tracked then you will only be able to build one batch / serial at a time to maintain 
traceability. 
 
 
Keying <ESC> at any point in the entry of the order header information will take you firstly back 
to the order reference input, allowing you to select another works order.  A second <ESC> at this 
point will ask whether you wish to ‘Abandon this Document’.  Reply ‘Yes’ or ‘No’ accordingly. 

Order Details OK? 
 
After confirming the document quantity the system displays details from the works order header 
asking you to confirm these are OK.  If you respond ‘No’ then you can update these details – for 
this document print only, then are not saved back to the works order, ‘Yes’ takes you to the next 
stage. 
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Stock Details OK? 
 
After confirming the order details are OK the system displays details from the finished stock item 
asking you to confirm these are OK.  Again, if you respond ‘No’ then you can update these details 
– for this document print only, then are not saved back to the stock record, ‘Yes’ takes you to the 
next stage. 
 

 
 

 
Order/Stock Details Displayed 

 
The details displayed for works order and stock confirmation are controlled by the 
document design parameters.  The document allows you to print items from both 
the Works Order Header and the Stock file – of these the first 10 works order 
header print items and the first 8 stock items are displayed for confirmation. 
 

Additional Details 
 
Before displaying the document details the system may pause to allow entry of additional details.  
Up to six items can be prompted for and, depending on document configuration; these can be 
saved back to the works order.  These options could be used to enter extra build instructions and 
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is configured via the ‘Prompts: Request Information from Keyboard’ options within the document 
design parameters. 

Recalculating Sub-Assembly Components 
 
On the build document then if sub-assembly components are exploded only where for insufficient 
stock then you have the option of recalculating the explosion requirements during the build 
process based on the current stock levels – items may have come back into stock or been built for 
shelf stock during the works order process.  A parameter option within the document controls 
whether this process takes place but, if configured, the recalculation is an automatic process. 

Display of Component Details 
 
The system then displays the component details, ten entries per screen, asking you to confirm the 
details are OK.  The standard configuration will display the details automatically, accepting the 
default quantities – the default being based on the quantity of the finished item confirmed in the 
header| earlier. 
 

 
At the end of each section of details you are asked ‘Are the above details OK’ – if you respond 
‘Yes’ then the process displays the next set of details, or if all details accepted the next section of 
the process.  If you respond ‘No’ then the system asks if you wish to abandon the document. 
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If there is insufficient stock of a component line you will be warned accordingly and prompted to 
abandon the order.  Respond as required. 
 

 
Confirming Detail Quantities 

 
Options do exist to allow confirmation of the detail action quantities within the 
document parameters (General Document Parameters 1), this setting may be 
desirable on the build process where more or less of a component may have been 
required than entered.  Note this option is not applicable when a works order 
contains sub-assemblies. 
 
When sub-assemblies components are both issued from stock and built (due to 
insufficient stock) then the system first issues the available stock and then builds 
the balance.  When fully building the works order this has no discernable effect, but 
where partially building a works order then this may result in component action 
quantities for level 2+ components being zero when the sub-assembly being 
processed is issued from stock rather than being built. 
 

 
If a component is batch/serial tracked then the system will pause during the display of the details 
for confirmation of the batch/serial item to be issued or, in the case of sub-assembly components, 
built and issued. 

Closing Information 
 
After confirming the component details then, depending on document configuration, the system 
may allow entry of some final details that can be printed and/or updated to the works order.  
Again, this option is controlled via the works order document design (the final six options on 
‘Prompts: Request Information from Keyboard’). 

Printing the Document and Updating Files 
 
The final stage of the works order print is to produce the document and update the works order 
and stock files. 
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Print the Document 
 
On confirmation to print the document, and you may be forced to print based on document 
configurations, you may be asked to select the printer to output the document to (configuration 
options allow selection at this point rather than on initial document selection). 
 
Another Printout 
 
Select if a second print is required.  If confirming printer at point of printing then you will again 
be asked for the printer to output the document to, if you selected at the start of the document 
process then the second copy is printed to the same printer.  The system remains on this prompt 
until you respond ‘No’. 
 
Document OK for Updating 
 
Confirm to update the files for the works order print / build.  Depending on document 
configuration you may be forced to update. 
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Reports 
 
You can print the Bill of Materials reports as and when you need them and this option groups all 
the reports for the Bill of Materials system in one menu. 
 

 
Prompts Used Throughout the Reporting Process 
 
Throughout the Bill of Materials reports there are a common set of questions whenever a report is 
printed – supplemented by others for the specific report.  These questions are displayed when you 
select the report.  If the responses to these questions are acceptable then you can select the PRINT 
button to print the report.  Alternatively you can use the mouse or the <TAB> key to position the 
cursor for the response you with to change. 
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Date of Report 
 
It is usual to print today’s date on the report.  You can overtype this with another valid date. 
 
Report “As At” Date 
 
Whilst the date above represents the date on which the report is printed, it is helpful to know up to 
what date the works orders files have been processed.  Often these are the same but it could be 
that works order entry is some way behind if the Datafile system is not the primary instigator.  
The report ‘as at’ date therefore is the date up to which works orders have been entered. 
 

 
Note 

 
The ‘As At’ date is a memo only for the purposes above – it has no effect on the 
details reported. 
 

 
From Order Ref 
To Order Ref 
 
You may be interested in just a group of orders, in which case these prompts allow you to choose 
a range of references.  The 'From' and 'To' references give the start and end of the range — and 
you can use the <F4–Select> key to help you choose the references you want.  If you leave the 
'From' reference blank, then the computer assumes you want to start at the beginning of the file.  
If you leave the 'To' reference blank, then the computer assumes you want to end at the end of the 
file.  This prompt is only applicable on the reports ‘Order Status’, ‘Works Order Specification’, 
‘List Order Headers’, ‘Analyse Orders’, and the ‘Consolidated Order/Stock Picking Sheets’. 
 
Specify Any Selection Criteria 
 
Selecting this option allows you to restrict the works orders (or works order details were 
appropriate) to those that match an entered criteria. 
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The OPTIONS Button 
 
When you select to print an application report an OPTIONS button is available alongside the 
PRINT/CANCEL buttons.  Selecting the OPTIONS button allows access to the print 
configuration. 
 

 
The layout of this screen differs slightly based on whether you have set the page size (as above) or 
not.  Before discussing the parameters you should note the buttons available at the footer of this 
parameter screen. 
 
Default - This option updates the individual parameters from your user default when they are set, 
overwriting presets where applicable.  If no user defaults are set then this option is ‘greyed’ out.  
To set user defaults see the appropriate section below. 
 
Accept - This option accepts your entered parameters for this print only, reverting to defaults next 
time the report is run. 
 
Save - Depending on whether the user is configured as an ‘Install’ user then the next option will 
be SAVE.  This saves your set parameters so they are offered as default next time this report is 
run (Note: this is system wide not per user).  Setting the user as an ‘Install’ user is achieved 
through the user configuration available under the MASTER sign-on. 
 
Abandon - This option abandons any changes made and returns you to the report screen. 
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The report parameters available are: 
 
 Paper Size – select the paper size the report is to be printed to (i.e. A4).  You can elect to 

leave this blank in which case the report is printed as per the last/default page size of the 
printer, however, if you do this you can only choose fixed pitch fonts – selecting a page 
size is mandatory to use proportional fonts. If you set a page size then the options screen 
re-displays with the appropriate parameters.  If you leave blank then the options screen 
remains as above. 

 
 Default Printer Font – a font dialog is display allowing you to select as required, the 

default font to be used for this report.  If you’ve sent the page size then all fonts are 
available, if you haven’t set this then only fixed pitch fonts can be assigned.  You can also 
set bold/italic attributes and font size – note that if you haven’t set a page size then the font 
size option is not applicable (font is sized as per previous rules). 

 
 

Selecting the Font Size 
 

Generally you can’t go far wrong with 10point.  However, if you have a lot of data 
items on your report, and are printing in portrait, 10point may be too big to fit all the 
required information without overlapping fields. 
 
The positioning of fields across the page is determined by the item size – if you 
imagine the Order Status listing report this shows, by default, the order reference (10 
characters), the status (6 – as field name is larger than field size), the date added (8), 
the assembly number (10), the stock code (16), the customer reference (15), and the 
date required (8), together with spaces between the items this gives a total of 104 
characters, or columns required, across the page (think graph paper – you have 104 
‘cells’ across the page). 
 
Those 104 columns are split equally across the available page (page size and margins 
taken into account) as starting positions for data items – so the order reference starts 
at column 1, the status at column 12 (order reference plus 1), etc.  If you select a font 
size too big then the order reference may not finish printing before the status starts 
causing the status to overlap the end of the order reference.  If this occurs then you 
may need to either reduce the font size or consider swapping the report to landscape 
orientation if the font size would go too small. 
 

 
 Default to Landscape – set to default the printed report to landscape, leave blank for 

usual portrait orientation.  You may want to set reports such as the Sales Ledger Aged 
Debtors Report or the Cashbook Receipts Analysis Listing to landscape as these reports 
require a large amount of detail to be printed and otherwise the font size could be too 
small. 

 
 Show Time in Report Headings – set to include the printed time in the report headings in 

addition to the printed date. 
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 Include Selection Criteria – set to print any selection criteria that were applied to the 
report. 

 
 Email as Text – if send this report via email this option allows you to send as a text file 

attachment as opposed to, if left blank, PDF. 
 
 Omit Full Page Headings – When printing a multi-page report the system repeats the 

headings for each page.  Setting this option reduces the heading details for the second and 
subsequent pages allowing more record detail to be printed per page. 

 
 Default Output to Spooler – Usually, when printing a report, the default printer is the last 

print device used.  Select this option to set the default printer as the spooler for this report.  
This acts only as a default and doesn’t prevent you electing to print the report instead. 

 
 Allow Change of Printer Alias – when these options are configured then it is assumed 

you are printing as ‘direct windows print’ and this is the alias set by default.  Setting this 
option allows you to change the default alias at run-time to one of the list of Datafile 
configured printers.  If you change the alias to a ‘DOS’ style alias then the page size 
(length/width) and font are again picked up from the Print Style Profile, although other 
settings such as ‘include time’ etc. remain from the OPTIONS display. 

 
 Print Negatives in Red – on selected reports, assuming you have a colour printer; it may 

be useful to print negative values in red. This option allows this. 
 
The next set of parameters allows you to specify formatting and margin settings.  This section is 
different if you set the page size earlier.  If you have set the page size then you set the margins in 
millimetres.  If you haven’t set the page size then you set margin in ‘columns’ for both portrait 
and landscape - the appropriate settings being used based on the orientation of the output selected 
at run-time.   
 
Paper Size Set 
 
 Characters Per Line – the system displays the width of the report items on the right.  If 

you leave this value at 0 (recommended) then the report width used in determining the start 
column positions of data items (as discussed above with regards to font size) is the larger 
of either the report print items or 80 columns.  You can manually set a report width – from 
64 to 255 columns.  You may want to increase the number of columns on (say) a landscape 
report with few print items to bring the fields closer together to aid in reading. 

 
 Lines Per Page – if left at 0 (recommended) then the number of lines per page is 

determined by the font and page size.  Alternatively you can set a number of lines per 
page, perhaps to give a greater gap between rows of data items. 

 
 Left Margin (mm) – set the size of the left hand margin (relative to page orientation in 

millimetres. 
 
 Right Margin (mm) – set the size of the right hand margin. 
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 Top Margin (mm) – set the size of the top margin. 
 
 Bottom Margin (mm) – set the size of the bottom margin. 
 
Paper Size Not Set 
 
 Minimum Characters Per Line – the system displays the width of the report items to the 

right.  If you leave this value as 0 then the report width is the larger of either the report 
print items or 80 characters.  You can manually set a report width – from 64 to 255 
characters wide – but if you set a width less than the items actually printed then this is 
overridden by the report width at run-time. 

 
 Maximum Lines Per Page – if left at 0 then when printing a report the system will 

determine the number of lines per page based on the report width and the printable area of 
the page up to a maximum of 72 lines per page in portrait mode or 50 lines per page in 
landscape mode.  Alternatively you can set the number of lines per page, from 16 to 255, 
and this is then taken into account when deciding font size to ensure that number of lines is 
printed.  If left at 0 then when sending to the spooler the lines per page is assumed to be 72 
in portrait mode and 50 in landscape.  If you require an identical print from the printer and 
the spooler then a maximum number of lines should be set. 

 
 Left Margin – set the number of characters to be used as a margin from 1 to 64.  If you 

require a margin then when entering the value you need to take into account the report 
print width – a margin of 4 characters on an 80-character report will be bigger than a 
margin of 4 characters on a 132-character report.  If left at 0 no left margin is applied. 

 
 Right Margin – if you require a margin to be applied on the right of the report set the 

number of characters accordingly (again 1-64), if leave as 0 then no right margin is 
applied. 

 
 Top Margin – set the number of lines to leave as a margin at the top of the page (1-32 

lines).  If left at 0 then no top margin is applied. 
 
 Bottom Margin – set the number of lines to leave as a margin at the bottom of the page 

(1-32 lines).  If left at 0 then no bottom margin is applied. 
 
Finally, you can set default options that are used when you send the report to print or e-mail. 
 
 Print Device – if using a stand-alone Datafile system then you can set a default printer to 

output to.  This option only applies when sending to a print device; if last printer was 
spooler or fax then this remains the default.  If using a networked Datafile system then you 
can still set this where you are printing to a networked printer – provided all terminals have 
a consistent device path.  If the print device isn’t valid then the normal printer is offered 
instead. 

 
 E-mail Address – if the report is sent to email then here you can enter an email address 

that is to be used by default for this report – though it can be amended at run-time. 
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Once you’ve set the desired parameters select the ACCEPT option to apply the settings for this 
print or, if available, the SAVE option to apply for this and future prints. 
 

 
 
Once you have changed the print parameters to your required settings you can then select the 
PRINT button to print your report. 

Report on Order Status 
 
This report shows a single line per works order and display’s its order status – A-Active, C-
Complete, etc. 
 

 

Works Order Specification 
 
The report shows a ‘statement’ style report of the works order and could be viewed as a printed 
works order enquiry.  In addition to the standard parameters some supplementary options are 
available. 
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New Page for Each Order 
 
Set by default this option forces each works order to start on a new page. 
 
Exclude Deleted Order Details 
 
If using as a printout of the works order enquiry or as an ‘audit trail’ you may want to see where 
order detail lines have been entered but deleted.  Select as appropriate. 
 
Exclude Desc-Only Details 
 
Set whether description only details – i.e. notes for build instruction – are to be excluded from the 
specification report. 
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Outstanding Orders  
 
This report lists all the works order details that have an ‘active’ order status. 
 

 

List Order Headers 
 
This report lists further details from the Works Order Header. 
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List Order Details 
 
This report lists information from the Works Order Detail database.  It is usually similar in 
structure to the ‘Outstanding Orders’ report but includes ALL details by default and not just 
active details.  This report includes two additional run-time parameters. 
 
Exclude Deleted Order Details 
 
If using as an ‘audit trail’ you may want to see where order detail lines have been entered but 
deleted.  Select as appropriate. 
 
Exclude Desc-Only Details 
 
Set if description only details, used for build instructions, are to be excluded from the listing 
report. 
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Analyse Orders 
 
This analysis report analyses the order headers by their status code.  For each status type the 
report shows the number of orders, the total number of order detail lines and the total cost value 
of the orders. 
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Stock Picking Sheet 
 
The stock picking sheet provides a list of components for active works order details that can be 
given to the warehouse so that components can be pulled from the shelves in preparation for 
building.   
 
In some circumstances, where additional instructions are required, a configured works order 
acknowledgement may be best for this.  In addition where processing several orders at once and 
the same components are in use in multiple orders the ‘consolidated’ picking sheets may provide 
a better solution. 
 
Show Breakdown of Stock into Batches/Serials 
 
Prompted in a pop-up after selecting to print the report this option controls whether the stock 
picking sheet is to include the details for any component that have pre-allocated batches/serials. 
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Consolidated Order Picking Sheet 
 
The order picking sheet produces a page per works order but groups the stock details together so 
that if the same component is required more than once in the works order (perhaps at different 
levels of assembly) then this provides totals of the quantities required. 
 
This report includes two additional parameters – both set by default. 
 
Consolidate Details by Stock Code 
 
If set then order details are listed by stock code with totals per stock code of the quantities 
required. 
 
Exclude Non-Stock Items 
 
If set then non-stock items are excluded when listing the components to be picked. 
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Consolidated Stock Picking Sheet 
 
The Consolidated Stock Picking Sheet groups the works order details by stock code for all orders 
processed and gives a total required quantity per component.  Two additional run-time parameters 
are available on this report – both set by default. 
 
Consolidate Details by Stock Code 
 
If set then works order details are listed in stock code order with totals per stock code of the 
quantities required. 
 
Exclude Non-Stock Items 
 
If set then non-stock items are excluded when listing the components to be picked. 
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Cleardown Options 
 
You use these options to purge you order files of completed and deleted orders.  You may want to 
do this to keep files sizes down to that batch runs and reports do not process a large number of 
‘dead’ orders.  However, some users like to keep these orders on file for reference purposes and 
with increases of system storage and processing capabilities keeping a large volume of history has 
less negative effects than in the past. 
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Remove All Completed Orders 
 
On selection of this option you are prompted to confirm whether you wish to remove all 
completed orders. 

 
If you respond ‘No’ you are returned to the menu.   
 
If you respond ‘Yes’ then the system processes the works order header and works order detail 
files and deletes any records with a ‘C-Complete’ or ‘D-Delete’ order status.  The system displays 
the number of records removed and prompts to check ‘File Usage’. 
 
File Usage 
 
When the system deletes a record it doesn’t automatically free up the space for re-use, instead a 
blank record is left within the file.  When you elect to check file usage the system displays the 
number of records reserved within the database, the highest in use and the number of deleted 
records.  If the highest record in use is close to the number reserved and there are a significant 
number of deleted records you may wish to compact the file so you can re-use the deleted records 
and delay expansion of the works order files.  NB:  Whilst larger file sizes will not cause any 
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problems within Datafile they do take up extra space on your system and can increase backup 
times. 
 

 
Do You Wish to Compact These Files? 
 
Respond ‘Y’ or ‘N’ accordingly.  ‘N’ returns you to the menu, ‘Y’ compacts the works order 
header and detail files and audits the pointers (i.e. rebuilds the links) between them.  This may 
take some time on larger files. 

Remove Orders by Date 
 
This procedure is similar to the above in that it removes completed orders from the works order 
system and frees up the space for re-use.  However, it adds additional selection criteria so that 
only completed orders older than the entered date are removed – keeping your recent history. 
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Remove Orders up to and including Date 
 
Enter the date for which completed orders are to be removed up to. 
 
Once the date is entered and you choose to proceed the remainder of the process is as per the 
cleardown procedures above. 

Remove Specific Orders 
 
This procedure asks you to enter specific order references to remove. 

 
Remove Order Reference 
 
Enter the order reference to be removed - <F4-Select> is available.  If you select an order that 
doesn’t have a ‘complete’ status you will be warned accordingly.  Once you have selected a valid 
order reference the works order header and details related to that order are removed and you are 
returned to this prompt to enter further order references.  Once all references are entered press 
<ESC> to move to the next stage. 
 
Once you’ve entered your references and pressed <ESC> the system moves to the ‘File Usage’ 
procedures above. 
 

Order Enquiry 
 
 
The Order Enquiry shows a summary of the Works Order providing details of its status and 
outstanding build requirements.  A screen similar to that shown below is displayed. 
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On selection of the ‘Order Enquiry’ option you are asked for the order you wish to enquire upon.  
You can either enter this, if known, or use the <F4-Select> search facility to find the required 
order.  Whilst the order details are displayed <F8-Zoom> is available to transfer to the Ledger 
Enquiry options for this works order which can show further details and allows transfer to the 
Stock Enquiry for the component details. 
 

System Status 
 
This option displays a summary of the current status of the Bill of Materials application in five 
sections. 
 
 Company displays the identifying code and name of the active company. 
 Files display the total number of order header and detail records reserved plus the highest 

in use. 
 Dates display the systems current date and the stock period dates. 
 Document Numbers displays the last number processed for each of the twelve document 

sequence counters available.  If you have kept to the conventional structure then sequences 
1-6 are for acknowledgements, and 7-12 are for build documents. 

 Last Order displays the reference of the last order added to the system. 
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Chapter 3 
 

Configuring Bill of 
Materials  

 
Your Bill of Materials system is part of your manufacturing process – it has to be configured well 
for efficiency and to ensure that it meets your requirements and a large number of options are 
available for you to do this.  Time and consideration spent on configuration will go a long way 
towards this. 
 
This section describes the options available within the ‘Installation’ section of the program to 
configure Bill of Materials.  When you select the Installation option a menu will be displayed that 
contains the installation and configuration options – only operators with the highest authority 
level (0) are allowed to process any of these options. 
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Lock Out All Systems 
 
When making changes to the Bill of Materials system then hat application has to be 
locked out via the option ‘Lock Out All Systems’.  Firstly, you are prompted to lock 
out all systems – it can sometimes be easier to lock all systems as you may have to 
change settings in other applications (Stock or Sales Order Processing for example) 
at the same time – if you respond ‘Yes’ then all applications are locked, if you 
respond ‘No’ then you can select to lock just the applications required. 
 

 

Set Application Code Formats 
 
This option allows you to set the prime index format for each of the application databases 
including the Works Order Reference. 
 

 
The default format for the works order reference is 999999 – this forces the reference to be a 
numeric sequence of six numbers.  If anticipating a large number of works orders to be 
maintained on the system, or you are transferring from an alternate system were the starting 
reference is already quite high you may want to increase the reference to seven 9’s or larger.  The 
maximum reference size is sixteen characters.  The ‘Company Name’ displayed here is used as 
the company name displayed in all reports including the Bill of Materials reports. 
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Set Company Details 
 
The Bill of Materials documents allow the printing of ‘data’ items for the company name and 
address details.  This can be a useful alternative to entering the address details as text on the 
document mask, when using plain paper rather than pre-printed stationery, as when address 
details change you only have to amend one setting rather than several. 
 
The settings for the address data items are defined here. 
 

 
 

System Profiles 
 
The System Profiles set the general configuration options for Bill of Materials. 
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Add One to the Order Reference Each Time 
 
If using a numeric order sequence (see ‘Set Application Code Formats’ above) then setting this 
option will enable the system to suggest the next order reference on the basis of the last order 
added, otherwise when creating the works order you will have to enter the appropriate reference. 
 
Always update BOM reserved/on-order for works orders 
 
When set all works orders automatically update the reserved quantity for the components and the 
on-order quantity for the finished item on the stock file.  If left blank then works orders do not 
update reserved.  If the ‘reserved’ flag is displayed for input on the works order entry screens then 
this setting acts as a default and can be amended as required on an order-by-order basis. 
 
Special Stock / Order Detail Copy Items on Build 
 
The Bill of Materials Database Profiles allow a series of copy items for ‘Stock UPD Detail’, these 
are actioned whenever an order detail record is updated within order entry.  When set this option 
allows these copy items to be actioned during the document build processes. 
 
Disable Stock / Order Detail Copy Items on Credits 
 
If the previous prompt is set then you may not want to action these copy items on your credit 
build or ‘de-kit’ documents.  Set this flag as required. 
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Title for “Column 1” detail item during order input  
 
‘Column-1’ is an extra user-definable order detail input (usually text based) that can be input on 
the Works Order Detail screens.  Here you specify the actual prompt used on screen.  This is only 
applicable for the ‘system’ detail screen or on fast input / detail pick entry – the ‘full’ detail entry 
screen would require amending separately.  The benefit this option has over the ‘extra’ items that 
can be defined in the Application User Facilities is that they are prompted before stock code input 
rather than at the end of the detail. 
 
Title for “Column 2” detail item during order input 
 
This allows a second user-definable order detail input item as per above. 
 
Select Method for Expanding Sub-Assembly Components 
 
This prompt allows you to configure how sub-assemblies are processed.  The available options 
are: 
 
0 Never Expand – if a component is a sub-assembly then a separate works order will be 

entered. 
1 Always Expand – if a component is a sub-assembly then will explode these items and 

create works order details for them regardless of the stock level of the sub-assembly item. 
2 Only Expand if Insufficient Stock – if a component is a sub-assembly then will explode 

these items and create works order details for them when there is insufficient stock of the 
sub-assembly item to issue 

 

Application Manager 
 
Selecting the Application Manager menu option gives a further sub-set of actions that are 
discussed in their own sections later. 
 

Ledger Enquiry Manager 
 
The Ledger Enquiry Manager allows you to configure the Works Order enquiry options available. 
 
Enquiries Allowed for this Company 
 
Although there are no specific ‘Bill of Materials’ options within here, this parameter screen does 
control whether the Ledger Enquiry as a whole is available for this application company. 
 
Applications Allowed 
 
This option allows you select whether you can enquire on Bill of Materials, amongst other 
applications, and the authority level needed before you can enquire. 
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Enquiries Configuration 
 
The option ‘Enquires Configuration’ allows you to configure the Ledger Enquiry for each of the 
applications.  After selecting Bill of Materials from the list of applications there are three 
configuration options available. 

Works Order Header File FULL Screen Design (Premier 
Only) 
 
In Premier systems you have the option to create a user-define screen in which to display details 
from the works order header over two screens.  On selection of this option you are asked if you 
wish to use a full screen layout and, if selected, you are taken into the design for the first screen. 
 

 
You design the screen as per the standard screen design procedures.  To enter text on the screen 
position the cursor where you want to start entering the text, by clicking the mouse, and then type 
in the text required.  To clear text use the spacebar to blank it out, use of the delete key will 
remove the character and bring any text later on the line one character closer.  If press <Insert> 
then text entry changes to INSERT rather than OVERTYPE mode. 
 
To draw lines on the screen switch to ‘Line Mode’ using the option on the Tools menu and use 
the mouse to draw a line by clicking at its start position and then drag the cursor to where you 
want it to finish (only horizontal/vertical lines allowed).  To delete a line click it with the mouse 
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(so that it’s highlighted) and then press the <Delete> key.  To switch back to ‘Text’ mode call the 
option on the Tools menu again.  A special option on the Tools pull-down allows you to quickly 
draw a screen border. 
 
To position a data item click the starting position where you wish to display and then either right-
click with the mouse or press <F4-Select> key – the available items are then displayed. 
 
Once complete choose the File pull-down option ‘Save & Exit’.  When you save the first screen 
you will be asked if you wish to use a second screen – respond as required. 

Works Order Header File ITEM Screen Design 
 
If Diamond (or Premier and you don’t wish to use the full screen design) then this option allows 
you to quickly configure the display of up to 32 items from the works order header file in two 
columns of 16 items. 
 

 
Here you list the items you want to display on, firstly, the left of the screen and then the right.  
The numbers displayed in brackets after an item indicate that a field is being displayed on this line 
on the other half of the screen.  If using Premier then you get the option to design a second screen 
in the same manner. 
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Transaction / Detail Enquiries 
 
Here you configure the authority level required to view the works order details, the items to be 
listed and, if Premier you are able to design an enquiry screen displaying further information from 
the works order detail. 
 

 
Firstly you are asked to confirm the authority level required to view the works order details – 0 is 
the highest, 9 the lowest – if blank out the authority level this disables the details option.  After 
confirming the authority selecting ‘Transactions/Details’ allows you to define the detail display 
items. 
 
Here you can select whether details are displayed in LIFO or DATE order (not usually set for 
works order enquiry) and then can select up to eight items from the detail database to be listed.  
Available items are listed on the right of the screen or they can be selected via <F4>. 
 
If Premier then after confirming the list items are correct you will be prompted if you wish to 
design a full-screen enquiry layout for the order detail – respond as required. 

Extra File Scans 
 
Set the authority level to allow scanning of documents against the works order from the Works 
Order Ledger Enquiry. 
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Controls & Audit Manager 
 
The Controls & Audit Manager contains all the utility routines used to check the integrity of the 
data database files and to undertake various housekeeping actions.  The tools supplied for Bill of 
Materials allow: 
 
 Check integrity of the databases (audit) and rebuild their index’s 
 Define the auto-expand parameters for databases 
 Check and reset application values 
 Recover Unused Space 
 
After selecting the Controls & Audit Manager menu option you are prompted to select the 
application and then you are presented with the options available for the application. 
 

 

Audit Pointers 
 
These options check and reset the relationships between the Works Order Header and Works 
Order Detail databases.  On selection you are asked whether you want to perform the check for all 
works orders or for individual orders – in practice you would choose do to this for all codes as 
there would normally be little difference in the time taken (the majority of the time being taken 
with reading the details). 

Reset Order Detail Entry Numbers 
 
As you maintain works order details the system assigns an ‘entry number’ for each detail you add.  
If you delete detail records then this can result in a ‘missing’ entry number which some operators 
do not like – this option resets the entry numbers on details for all orders. 

Edit System Status Display 
 
Each application has a ‘System Status’ that summarises the key facts about it, such as files, their 
sizes and how full they are, current period numbers and various other control information such as 
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last transaction reference and order reference.  For Bill of Materials the ‘Edit System Status’ 
option allows you to reset each of the twelve document sequence options and the last order 
reference added. 

Database Audit 
 
Use this option to check the internal integrity of any of the Bill of Materials application files.  If 
you’re sure that a particular record is in the file but you cannot select it via the indexes then you 
might want to use this option on that file. 
 
Really the only events liable to disturb the integrity of a database are power/hardware failures or 
an attempt to process a database in an outside program.  The database audit checks every record in 
the file to make sure it is genuinely active and rebuilds its indexes from scratch. 
 
When you choose this option the works order header and detail databases are listed for you to 
select from – it is recommended that if you have the need to do one of the databases within the 
application you should probably do them all and follow it up with the ‘Audit Pointers’ option. 

Compact & Audit Database 
 
The internal processing of databases does not necessarily re-use the space occupied by records 
that have been deleted.  New records are always added to the end of the file.  Therefore, over a 
period of time, it is possible a file may appear full but there could be gaps in the middle where 
records were deleted.  Using this option consolidates the active data and frees up space. 
 
This option effectively re-arranges all the active records so you must run the ‘Audit Pointers’ 
function after using this option.   

Set Auto Expand Data Files 
 
Datafile reserves a fixed space for database files and you need to expand that space should the file 
become full.  This option allows you to set internal system parameters sot that it automatically 
attempts to enlarge a file that is becoming full.  The file is expanded when a user opens the file 
provided no-one else is already using that file, typically it would occur at the start of the day when 
the first user accesses an application. 
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Expand By  
 
Enter the number of records by which you wish the system to expand the file when triggered.  
Strike a balance between too small a number, meaning that it would happen to frequently, and too 
large a number which would mean it would take a long time to expand the file and take up 
unnecessary disk space. 
 
When Less  
 
This represents the quantity of free records which when below will trigger the automatic 
expansion when a user has exclusive access to the file. 
 
Minimum Spare  
 
This is an important parameter for files where batches of records are added – it represents the 
minimum quantity that must be free at all times.  It would normally be less than the ‘When Less’ 
setting and if this setting reached implies that no user has had exclusive access to the file since the 
‘When Less’ quantity was reached.  You should set the minimum to be the largest number that 
can be added through an automatic update. 

Expand Data Files 
 
If not setting the auto-expand options then this option allows you to manually expand the data 
files as necessary. 
 

Security and User Manager 
 
The Security and User Manager allows you to set authority levels and passwords on specific 
application options and to define any user authority overrides.  After selecting the application two 
screens of options are allowed for security checks. 
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In the first screen you may attach a password and/or an authority level for each of the main Bill of 
Materials options.  If Premier and logging options have been enabled then you can log operators 
who attempt to enter password/authority protected areas and fail.  You can also nominate 
operators, who are nominally blocked from this company by their authority level, to be allowed 
into this application. 
 
On the second screen you are allowed to specify passwords/authority-levels for more specific 
order entry options. 
 

Document Design Manager 
 
On selection of ‘Bill of Materials Documents’ you are given a menu of the two document types – 
Print Works Orders and Build Works Orders – select as appropriate.   
 

 
On selection the list of available documents is displayed. 
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If you want to update an existing document enter the layout number in the input provided, if you 
want to create a new document you need to firstly add it to the list by: 
 
 Press <F4-Select> to allow amendment of the list. 
 
 Find a blank entry and enter the document title. 
 
 Enter its definition filename – filenames usually follow the convention CCC-PWON.DEF 

where CCC is the company id, PWO is ‘Print Works Order’ (so PWD for ‘Print Works 
Delivery i.e. build notes) and N is the layout number 1-6. 

 
 Press <End> to go back to the document layout selection. 
 

 
Notes 

 
A document definition is held in two files – a filename.DEF listed above contains 
the document parameter details, and a filename.INI contains the font settings, line 
and box drawing and image file(s) detail.  The INI file is created automatically on 
first load of the document. 
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Create Document Based on Existing 
 
If you select the newly added document now then this creates a blank document, if 
you want to create the new document based on an existing layout then use the <F7-
Option> key to copy the definition from one file to another. 
 
Note you can only copy Bill of Materials documents – you cannot copy, for 
example, a Sales Order Processing document. 
 

 
On input of the layout number you are presented with the document template. 
 

 
Converting a Document 

 
Previous to release 5.6 documents were designed in a different manner.  Whenever 
you open a document that was designed using the old designer you will be asked to 
convert to the new layout. 
 

 
To convert to the new style select ‘Use New Designer’, if you want to continue with 
the old layouts then select ‘Use Old Designer’.  To abandon select the ‘Close’ 
button. When you use the new designer for the first time a backup copy of the old 
layout is taken as filename.OLD which you can copy back if needed.  If you do this 
you would need to delete the filename.INI discussed above. 
 

 
When creating a document for the first time or opening an older style of document you will be 
prompted for the page setup details. 
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Paper Size – offers a drop-down list of paper sizes available.  Select the paper size appropriate. 
 
Print in Landscape – set whether the document is to be printed in landscape.  Leave blank to 
print in portrait. 
 
No of Columns Across / No of Lines Down – if converting an older document this defaults to 
values as previously defined on the document - typically you would leave these values as set for 
your document.  For new documents this will default to 80 columns across and 66 lines down and 
you can amend as required. 
 
These values can be amended up to 255 columns across and 132 lines down.  The columns and 
line values form a ‘design grid’ on the document with the no of columns set controlling the 
number of grid start points across the page, the lines down controlling the grid points down the 
page (think graph paper).  Text, Image and Lines do not have to start at a grid point but data items 
do – increasing the number of columns / grid points across the page gives you more flexibility 
with regards to data item positioning.   
 
Take care on increasing this value on existing documents as items starting at a particular 
column/grid point may overlap if you increase the number of columns.  With regards to the 
number of lines down, again take care increasing this value on existing documents as line items 
may overlap – in addition though increasing this value too far may cause the print of detail lines 
to overlap if the font of detail items selected for print is bigger than the line height. 
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Start Detail Line / End Detail Line – if converting an older document this defaults to values as 
previously defined on the document - typically you would leave these values as set.  When 
opening a new document this will default so that a quarter of the page acts as the header and a 
quarter of the page is the footer – the balance being the detail area. Where on the statement the 
outstanding transactions are listed. 
 
Margins – next you can set, in millimetres, the left, right, and top and bottom margins.   
 
When you print a document each printer has its own internal set margin and the grid (discussed 
above) is fitted within this.  If printing a document on multiple printers, especially when using 
pre-printed stationery, you should set the margins on the document equal to or greater than the 
largest margin of the printer(s), to ensure identical print on all printers.  The Install menu on the 
toolbar allows the option ‘View Printers’ which enables you to perform a test print which shows 
the print margins (as a border on the page). 
 

 
Notes 

 
The Install menu on the toolbar (desktop) is only available for the SYSTEM user-id 
and for Premier users set to use the ‘Installer’ desktop. 
 
 

Once you have set/confirmed the margins the document mask is displayed. 
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A document is split into three sections – a header, a detail and a footer area as mentioned above.  
In statements the header area is used to print details of the customer and the finished item.  The 
detail section prints, line-by-line, the components required.  The footer area shows totals such as 
the cost value. 
 
The Document Design Toolbar 
 
Before discussing the specifics of designing a document, you should review the document design 
toolbar. 
 
The toolbar has the options – File, Edit, Tools, Parameters and Format.  Each of these (other than 
Parameters) offers a list of actions available. 

 
The File menu has options to save the document layout, amend/view the page 
set-up, preview the design to the screen, perform a test print of the document, 
and exit out of the document design (you will be prompted to save if you 
haven’t already done so). 
 

 
The Edit menu has options that are only available when an item on the 
document is selected.  You can cut an object out of the design, copy an item 
(except data items), or delete an item.  You can also insert a line above the 
selected item or delete a line with the selected item on.   
 

 
The Tools menu has options to restructure a database, refresh the display, 
and controls for whether you show the data items (you may want to switch 
this off to position text behind it), whether you show the grid, and whether 
new text/line/image items are to be positioned at the start of the grid. 

 
The Format option allows you to select a bitmap image to act as a 
watermark behind the page detail, set and applies font defaults, and 
configure printer, email and fax settings. 
 
 
 
 

 
The Parameters option loads the first of the parameter screens available for this document. 
 
Setting and Applying Font Defaults 
 
Before you start to design your document you may wish to set default fonts for each area of the 
document.  You can amend the fonts for each item individually but initially you are likely to want 
to assign a default font for all items in a specified area.  
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Each document has three areas – header, detail and footer.  The detail area starts two lines above 
the start detail line (to encompass column headings for the details) and finishes at the end detail 
line.  The header area is above the detail area, the footer below.  The only documents that don’t 
follow this format are purchase cheque layouts, payroll and invoice generator documents which 
don’t have set detail area – on these documents the ‘header’ area encompasses the entire page. 
 

 
Converting an Existing Document 

 
When you convert an older style document a font of Courier New is assigned to the 
existing data and text items.  You can use the Font Default options to reset the 
font/size of these items as required. 
 
In the earlier designer text was created on the document by positioning the cursor 
and typing the required text.  In converting this into the text labels of this new 
designer the assumption is made that text separated by a single space is part of the 
same label, more than one space and two (or more) separate labels are created.   
 
 

To set and apply default fonts select the Format option from the toolbar, choose Font Defaults 
and then the area you wish to apply the fonts to – a dialog box will be displayed enabling you to 
select the font, style and size. 

 
You can scroll up/down the list of fonts, 
use the mouse to select the required option 
(once selected the chosen value will be 
updated at the top of the list).  After 
selecting the font, select the style and then 
the size.  You can also amend the colour of 
the text if required.  Once you have 
selected the required details press OK. 
 
After selecting the font you can control 
whether it applies to the text items or the 
data items in the defined area (or both or 
indeed neither – you might set a default 
because the next x items you are going to 
insert all use a specific font).  Tick the 

options required and click the APPLY button. 
 
Once you have set and applied the default fonts you can then adjust the font and size of individual 
items as required. 
 
If you have need to reset all items to the set default fonts then choosing the Apply Fonts option 
available from the Format pull-down allows this. 
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Inserting New Items 
 
To insert a new item position the mouse where you wish to insert the item and press the right-
button on the mouse (hereafter described as right-click).  A menu appears for you to select the 
type of item you wish to add. 

 
You can select to insert a text prompt, a data item, some line drawing, box 
drawing, or insert a bmp image. 
 
You can also elect to insert a line on the document at the current position or to 
delete a line.  The ‘Paste Object’ option (greyed out in the picture on the right) 
is active if you have used the ‘Cut’ or ‘Copy’ option from the edit menu 
previously. 
 
 

 
Text Prompt 
 
If you select to insert a ‘Text Prompt’ a pop-up form allows you enter the text label to be 
displayed. 
 

 
You type the text you require (up to 160 characters).  If you click the APPLY button the text is 
updated onto the document design in the default font/size for the area of the document.  If you 
wish to change the font select the FONT button and the font dialog is shown as discussed earlier 
(you are setting the font for this item alone).   
 

To change the colour of the background to the 
text select the COLOUR button and a colour 
dialog will be displayed allowing you to select 
from a pre-defined colour set or allow you to 
create up to 16 custom colours of your choosing. 
 
To define a custom colour click with the mouse 
on the colour panel display and then move the 
scroll panel on the right to control the 
luminescence.  Once your happy with the colour 
select the ‘Add to Custom Colours’ button and 
the colour will be added to the custom colours 
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on the left for selection. 
The ‘SNAP’ button is used to position the text item at the centre of a row and at the start of a 
column – snapping the text to the grid.  The ‘DELETE’ button removes the text and returns you to 
the document mask. 
 
Once you are happy with the changes select the CLOSE option to update the text label and return 
to the document mask.  If you wish to abandon click the X button in the corner of the Text 
Properties window. 
 
This isn’t all the options available though – if you select the 
ACTION pull-down menu, in addition to the button prompts 
(with a bit more description) are further options to reset the font 
and colour to default settings, save the font and colour to and 
set from the palette – this is useful if making the same changes 
to several items.   
 
You also have the option to add a border around the text label, 
and to right align the text within the label.   
 
Finally you can choose to abandon changes or accept and 
update the changes. 
 
Data Items 
 
If you select to insert a new ‘Data Item’ then a pop-up form allows you to select the data item to 
be displayed. 

 
To select an item you need to select the category of item and then the print item itself.  Drop 
down lists are available for each – use the mouse to activate first the category list. 
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Available categories are: 
 
 Document Headings (1st and 2nd Print) – allows print of selected ‘heading’ items such as 

the Order Reference, Date Printed and Assembly and Stock codes. 
 
 Document Detail Lines / End of Detail – allows print in detail area of stock, quantity and 

cost details. 
 
 Document Totals – allows print of total works order value 
 
 Order Header Items / Extra – allows print of items from the Works Order Header. 
 
 Order Detail / End of Detail – allows print of items from the Works Order Detail. 
 
 Order Detail Items to Total – allows print of a total value of nominated order detail 

items. 
 
 Header Batches – allows print of batch/serial details for finished item 
 
 Detail Batches – allows print of batch/serial details for component items. 
 
 Stock Details – allows print of stock details for finished item. 
 
 Keyboard Prompts – allows print of configured keyboard inputs. 
 
 Continuation Documents – allows print of header/footer text and values for print on 

works orders which are greater than a page in length. 
 
 Company Details – allows print of company name and address details. 
 
Once the category is selected choosing the print item drop-down list shows the items available for 
selection in this category. 
 



68  Bill of Materials 

Datafile Bill of Materials 
12/02/2007 

 
Items with a  after them are already used within the document so you cannot select these again.  
Some categories allow you to choose direct from the database the items to print.  For these items 
the ‘–‘ character as the print item represents a free item available for you to define.  If you select 
this then the appropriate database is displayed for you to select a data item from. 
 

 
Once you have selected the item then the options are available, as with text, to change the font, 
background colour or delete.  ‘Snap to Grid’ is not available on data items as data items are 
automatically ‘snapped to the grid’. 
 
Line Drawing 
 
If you select to insert a new Line – either horizontal or vertical - then a short line is drawn on the 
page.  This can then be extended by moving the mouse to the end of the line (until the cursor 
changes to an arrow) and then clicking with the mouse and dragging it for the length required. 
 
Box Drawing 
 
If you select to insert a Box then a small box is drawn on the page.  This can be extended by 
moving the box to a corner (until the cursor changes to an arrow) and then clicking with the 
mouse and dragging it for the size required. 
 
You can position items within a box by right-clicking and choose the new option required – if you 
click on/near the box border you are assumed to be amending the box though, so if want an item 
up against the border insert it elsewhere and move it to the position you want.  If you wish to 
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include lines within a box, perhaps for a column border, or an image then draw the box first and 
add the lines/image afterwards. 
 
Image File 
 
If you select to insert a new ‘Image’ then a pop-up form allows you to select the image to be 
displayed. 
 

 
You are asked to enter the image filename (BMP or JPG files only).  You can browse for the file 
by clicking the ‘?’ icon or pressing <F4-Select>.  Images are held in folder ‘DocImage’ created 
automatically off the DFCOMP location (usually \DFWIN\DATA).  
 

 
Although you can browse to other folders from here you can only select to apply images from the 
‘DocImage’ folder – if necessary you can copy from another location and paste here via the file 
selection browser. 
 
Once you select the image file its filename is returned to the document to be applied.  Note that 
the image is sized as per the file and cannot be resized within Datafile – you must use an external 
package to resize if you need to do this. 
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Moving, Deleting and Amending Items 
 
You can move an items position by selecting it with the mouse and dragging it to where it’s 
required.  If the ‘Tools’ option ‘Snap to Grid’ is enabled then all items start in a specified grid 
point, if switch this off then all bar data items can be set anywhere within the grid cell. 
 
You can delete an item by selecting it with the mouse and pressing the <DELETE> key. 
 
If you right-click with the mouse on any item then a menu is available allowing you to change the 
properties. 

 
Right-clicking against a Text item allows you to access the 
properties in full and allows individual options to amend the 
font, set the background colour, add (or remove) a border, right-
align the text, or snap to the grid. 
 
You can also reset the font/colour to default values or save the 
font and colour to the palette for application to another item 
using the Set option.   
 
You can also delete the text item from here. 
 
Right-clicking against a Data item allows you to access the 
properties box in full and allow individual options to amend the 
font, amend the background colour, add (or remove) a border, 
or to right-align the data item. 
 
As with text you can reset the font/colour to default values, 
save/set the font and colour from the palette or delete the item. 
 
  

 
Right-clicking against a Line item allows you to access the properties in 
full, amend the line colour, snap the line to the grid and to delete the line.   
 
 

 
Right-clicking against a Box item allows you to access the 
properties in full, amend the background (fill) colour of the 
box, set/clear round corners, snap the box to the grid and to 
delete the box. 
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Right-clicking against an Image item allows you to access the properties 
of the image or to delete it. 
 

Document Watermark 
 
You have the option to add a bitmap behind the entire document to act as a watermark.  (If 
converting an earlier document that had a bitmap background then this is set as the watermark for 
the current document.) 
 
The Format pull-down menu allows the option to edit the watermark giving options to ‘add’, 
‘change’ or ‘delete’.  The ‘change’ and ‘delete’ options are suppressed if no watermark has been 
applied, the ‘add’ is suppressed if you have applied a watermark.   
 
Selecting the add, or indeed the change option opens the file browser in the DocImage folder 
allowing you to select the BMP file.  As with images you must select the bitmap from the 
DocImage folder.  The watermark image is displayed automatically in the designer but you can 
switch this off by deselecting the ‘Show Watermark’ option available on the Format pull-down. 

Print Preview and Test Print 
 
You can preview the document to the screen or the printer from the File pull-down menu.  
Selecting the Print Preview option shows the document on screen.  You can use the scroll bars to 
move up/down/across the document.  <ESC> or clicking the X-close button returns you to the 
document design. 
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Selecting the Test Print option loads the printer dialog allowing you to send the document to the 
printer, spooler or a PDF file. 
 

Printer Settings 
 
This option allows you to set a default printer and tray for the stock document. 
 

 
Clicking the drop-down list shows the printers available from the pc for you to select, after 
selecting the printer the list of trays can also be selected from a drop-down list.  Note that this 
option assumes that the same printer is available, on the same device path, from all terminals that 
will process the particular document.  If the printer is not available the usual default will apply. 
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Bill of Materials documents are slightly more complicated than others as they already allow 
default printing options via screen 14 of the document parameters and these features need to be 
compatible with these options. 
 
As Bill of Materials allows the setting of two print devices via screen 14 the ‘Print Settings’ 
option also allows the setting of two printers / trays.  If set the first print settings on this screen 
then the default/automatic printer on screen 14 should be set to either 0 or 106 (any other setting 
on screen 14 will override the setting here).  If set the second print setting on this screen then the 
automatic 2nd print on screen 14 must be set to 106 (if left as 0 no second copy will print, any 
other setting would again override this printer here). 

E-Mail Settings 
 
The E-Mail Settings option allows you to configure default message details if the document is 
printed to E-Mail.   
 

 
 
Data item containing e-mail address  
 
Select data item from WOH database that contains the email address the document to be sent to. 
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Send Automatically  
 
Controls whether the message is to be displayed for confirmation/amendment before sending.  See 
notes on Microsoft Outlook / Outlook Express below. 
 
Filename to Save As 
 
The document is saved as an attachment to the email with a filename of the document title.  You 
may want to save with a more relevant name.  You only enter the filename not the path or suffix 
and you can use ‘!nnn’ to pick up a value from the main file record (where nnn is a three-digit 
data item number – 002 etc.).  Data Items available can be viewed by clicking the LIST button at 
the foot of the parameter screen. 
 
Address 
 
This option asks for a ‘hard-coded’ email address to which to send the email to.  You may use to 
(say) send the document to the warehouse. 
 
Subject 
 
Enter the subject of the email.  Again you can use !nnn to pick up a value from the main file 
record and in addition to the standard 160 fields available from the database you can use special 
items to pick up: 
 
 161 – Document Date 
 162 – User Name 
 163 – Document Reference 
 164 – Document Balance 
 
Message 
 
Enter the message detail as required.  Again you can use !nnn to pick up items from the main file 
or include the extra 161+ items above. 
 
Wordwrap 
 
When you send a message the text is output as entered above but the use of !nnn items may cause 
one line entered in the message to overflow into two lines on the email.  Setting the option to 
word wrap outputs the message text as paragraphs, a new paragraph starting after a blank line.  
You can also force a new paragraph by entering ‘%%’ at the start of the line. 
 
Automatic Emails and Outlook Express / Microsoft Outlook 
 
Security developments in later versions of Outlook Express and Microsoft Outlook mean that, by 
default, you cannot send emails automatically – a message is displayed warning that a program 
(i.e. Datafile) is trying to send an email message and asks whether you wish to proceed with the 
send (and you can’t respond Yes for a number of seconds).  This feature was introduced to 
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prevent viruses spreading themselves to everyone in your address book.  This feature cannot be 
disabled by Datafile. 
 
Outlook Express can be set to disable this warning via the Tools / Options menu and the Security 
tab.  Disabling ‘Warn me when other applications try to send mail as me’ will prevent the warning 
message.  If you do this you must ensure that your virus checker and firewalls are currently up-to-
date and are kept up-to-date. 
 
Microsoft Outlook does not have an equivalent option to this.  Microsoft Support does notify that 
if using Outlook on top of Exchange Server then you can set via ‘Administer Outlook Security’ 
tools trusted programs that are allowed to send emails automatically. 
 
Finally, Outlook Express can be set to send mail immediately on creation.  When this is set the 
email message is sent after each document is produced in Datafile, and Datafile cannot continue 
to the next document until Outlook Express has sent the message.  As you might imagine even on 
a broadband connection this can take some time.  Within Outlook Express selecting Tools / 
Options and the ‘Send’ tab allows you to disable the option to send mail immediately. 
 
Automatic Email and Anti-Virus Software 
 
As with the security checking introduced by Microsoft, anti-virus checkers can also look for 
several e-mail messages being sent in a short period of time.  Anti-virus checkers generally warn 
when more than one message is sent with the same subject (which could be avoided by using the 
!nnn function to pick up a value from the main data item record), and also warn if a number of 
messages are sent within a number of seconds (these details depend on the virus software).  
Generally the Anti-virus software will pause the sending of the email message(s) and ask you to 
confirm it is OK to send. 
 

Fax Printing 
 
Selected fax software, such as Tobit David and Zetafax, allow programs to pass information to 
them with regards to fax and contact details.  This option allows you to enter those commands and 
pick up fax and contact details from the customer / supplier account (the databases available 
dependent on the document type). 
 
You have the ability to enter up to ten lines of control text that will be passed to the fax printer 
(note if you print this to a standard printer directly – i.e. not print to the fax printer – these 
commands will appear on the printout) which will allow you to pass detail such as fax numbers 
and contacts. 
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To pass information from the database, such as a fax number, you enter the command 
(@@NUMBER for Tobit), followed by a space and then a ‘!’ and a three-digit number, finishing 
with any closing command (@@ for Tobit).  Data items available are shown on the LIST button 
including special options for document date and user name. 
 
Include commands when sending to the spooler – If left blank then the commands will not be 
included if you send the document to the print spooler.  Note that if sending document runs to the 
spooler containing multiple commands for different contacts then Tobit for one cannot interpret 
the print job correctly. 

Document Parameters 
 
In addition to the design features accessible from the document mask there are various parameter 
screens which can be used to configure the printed output and the processing of the document.  
When you select Parameters we automatically display the first of these parameter screens.  You 
can navigate between the parameter screens by using the options available at the bottom of the 
parameter screen. 
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The PREVIOUS button, available on all bar the first parameter screen, takes you to the previous 
parameter screen.  The NEXT button, available on all bar the last parameter screen, takes you to 
the next parameter screen.  The OK and CLOSE buttons both return you to the document mask. 

 
The ACTION pull-down lists the parameter screens 
available allowing you to go directly to the required screen if 
desired. 
 
In addition to the buttons you can navigate between pages by 
use of the <Page-Up> and <Page-Down> keys.  The <End> 
key will also take you to the next page and the <ESC> key 
will return you to the document mask.  Note that once you 
have changed the value of an item then the value is updated 
to the definition – if you want to reset it you must either 
change it back or exit from the document design without 
saving. 
 
 
 
 
 
 

 
General Document Parameters 1 
 
Number of Lines down the Document 
 
Set the number of lines to be printed down the document (max 132) 
  
Width (of each line)  
 
Key in the number of characters of the document width.  Max. is 128 characters. 
 
Lines where document detail starts/ends 
 
These questions refer to the first and last printing lines in which detail entries are to be printed. 
 
Credit Note Document  
 
You usually have different documents for credit notes. If this document is to be used as a credit 
note set this question 
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Allow Credit Note against Non-Credit Order  
 
If this is a credit note then normally the document could only be processed against a works order 
which is flagged as a credit order.  When set this option allows you to run a credit document 
against a ‘normal’ order. 
 
Re-Activate  
 
If crediting against a completed works order you may want to re-activate the order to allow 
further processing. 
 
Select Which Orders to be Processed  
 
This allows you to specify how the order is to be selected in the document.  Although you would 
normally leave this as 0, three responses are allowed 
 
0 You Specify – no default is offered and you select in normal manner. 
1 All Outstanding – defaults the order reference to process to the first outstanding order. 
2 Every Order – defaults the order reference to the first Order Reference on file.   
 
Default to Which Assembled Quantity  
 
This prompt asks you to select the default quantity to process of the finished item when 
processing the document.  You would normally have this set as either Order Quantity or 
Outstanding Quantity but the options available are 
 
0 Quantity Outstanding – the quantity awaiting build 
1 Order Quantity – the quantity originally ordered 
2 Last Quantity – the last build quantity (if for example you wanted to print an 

acknowledgement with different details after a build) 
9 Zero – defaults to 0. 
 
Default to Which Component Quantity  
 
This prompt asks you to select the default quantity to process of the component item when 
processing the document.  You would normally have this set to ‘4-Calc Quantity’ but the options 
available are 
 
0 Quantity Outstanding – the total component qty awaiting issue 
1 Order Quantity – the total component qty originally entered 
2 Last Quantity – the last quantity issued on a build 
3 Delivery Outstanding – the total component qty awaiting issue 
4 Calc Qty – this defaults the component issue qty based on the qty of the assembly to be 

processed and the number of components such a quantity requires. 
9 Zero – defaults to 0. 
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Omit Prompt for component qty (accept above)  
 
This option allows you to suppress at run-time the option to confirm the defaults for the assembly 
and component quantity and automatically accepts the above. 
 
Print Zero Quantity Selections Outstanding  
 
Normally if a detail is not processed (i.e. a quantity of zero is entered against it) then it is not 
printed either.  This option, when set, prints the detail if it is still outstanding. 
 
Include Description Only Details  
 
This option controls whether the build instructions, entered as description only details, are to be 
printed on this document. 
 
Use Stock File Only (No Transactions)  
 
This option when set updates the quantities processed onto the Stock record but suppresses the 
generation of stock transactions. 
 
Update Order Header and Detail Files  
Update Stock and Stock Transactions 
 
Generally speaking on both the Order Acknowledgement and the Build Note you update the 
Order files – this means on an Acknowledgement it updates the reference and date details and on 
a build updates the works order record to show the build (as well as reference and date details).  
The Build Note is normally set to update stock to update the physical movements of the assembly 
and component items. 
 
Allow Adjustment of Assembled Quantity and W/Off  
 
The assembled quantity processed is set according to the default quantity above.  If this option set 
then you can overtype this quantity and reduce/increase as required. 
 
Allow Adjustment of Component Quantity  
 
The component issue quantity is set according to the default quantity above.  If this option set 
then you can overtype the quantity and reduce/increase as required. 
 
Keep Assembled Items on Back Order by Default  
 
If allowing adjustment of quantities then if you process less than the outstanding quantity you will 
be asked whether the remaining is left on back order.  This prompt sets the default response as 
‘Yes’. 
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Don’t Complete Based on Qty (Ask if Complete) 
 
Set to prompt the operator whether the works order is complete after build (default is ‘No’) this 
allows the under/over build (subject to write-off parameters) of the works order. 
 
General Document Parameters 2 
 
Update Which Number Sequence  
 
This prompt determines which sequence you use for the reference number printed on the 
document.  Up to twelve sequences are allowed for Bill of Materials, six for the Works Order 
Acknowledgement and six for the Build Note.  Each document can be assigned it own sequence 
number or it can share the sequence number of another document. 
 
Use Order Number as Document Number  
 
Instead of having a document sequence you may elect to use the order number as the document 
number (provided that the order number is numeric and less than six characters).   
 
Prices to 4 decimal places (otherwise 2)  
 
You can specify M-type data items for prices in the stock and works order files, if these are set 
then you need to set the document to print prices to 4dp. 
 
Document Headings (1st Print) 
 
This screen allows you to set co-ordinates, expressed as the line number and printing column 
number, where you wish to print the Order Header information.  You would normally position 
these items from the document mask (using F4-Select to select the category/item). 
 
Order Reference – the Works Order Number 
Date – the date the document printed at 
Date Required – the required date entered on the Works Order Header 
Assembly Code – the assembly number the works order was entered for 
Stock Code – the stock code of the finished stock item the works order is building 
Quantity – the quantity of the finished item being processed on the document 
Build Wastage % - the wastage percentage of the assembly 
Document Number – the document reference  
Account Code – the end-customer, if any, the works order was entered for 
 
Document Headings (2nd Print) 
 
This screen allows you set the co-ordinates for an optional 2nd print of Order Header details 
above. 
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User Defined Column Entries 
 
This screen allows setting of co-ordinates for ‘text’ order detail items.  In the case of detail print 
items you only need to set the horizontal ‘column’ print position.  As with the document headings 
you would normally set the printing positions from the document mask though size/indent settings 
would be amended here. 
 
Column-1 – set size and printing position of the ‘column 1’ detail item. 
Column-2 – set size and printing position of the ‘column 2’ detail item. 
Description column/width – set printing position of the component description and size of 
description to print (normally you would set the width the same as the data item width of 
description but you may reduce if required) 
Order Detail Entry Number – this gives a counter of the detail entries printed. 
Assembly Level Number – prints the assembly level of the component 
Stock/Product Column – set printing position of the component stock code. 
Sub-Assembly Stock/Product Indent – set the number or characters the stock code is to be 
indented for second (subsequent) assembly levels. 
Cost per factor – the cost-per-unit setting of the component stock item. 
Unit of Issue – the text issue unit (KILO, EACH, etc) recorded on the stock record. 
 
Column Entries for Values 
 
Here you can specify the printing position of the line value items.  Unlike text items when 
printing a value you specify the printing position ‘Before Decimal’ – i.e. the significant figures, 
the ‘After Decimal’ – i.e. the pence and ‘Print Decimal’ whether you print the decimal point.  In 
practice you would position these items from the document mask using F4-Select and these 
values would be set for you. 
 
Quantity – the total component quantity issued on this document 
Cost Each – the unit cost of the component 
Quantity x Cost – the value of the components issued 
Sub-Assembly Quantity – the quantity of a sub-assembly built for issue 
Build Wastage % - the assembly wastage percentage applied to the component 
Stock Wastage % - the stock wastage percentage applied to the component 
Original Order Quantity – the original quantity ordered 
Original Build Quantity – the original build quantity required. 
Physical Stock Quantity – the quantity currently recorded as physical qty on stock record 
Reserved Stock Quantity – the quantity currently recorded as reserved qty on stock record 
On-Order Stock Quantity – the quantity currently recorded as on-order qty on stock record 
Free Stock Quantity – the quantity currently recorded as free-stock (physical + on-order – 
reserved)  
Available Stock Quantity – the quantity currently recorded as available qty (physical – reserved) 
Shortfall Stock Quantity – the quantity you are unable to process due to insufficient stock. 
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Omit Printing of Zero Value Entries  
 
If the value (qty x cost) of a component entry selected is zero then if this set then the entry will 
not be printed. 
 
Base Shortfall On  
 
If printing the shortfall quantity then this can be calculated based on physical, free or available 
stock.  Set as required – note if BOM is updating reservation details to stock you would normally 
set this as ‘0-Physical’ 
 
Maximum Size of Values Printed  
 
This prompt refers to the maximum number of significant digits (i.e. the value before the decimal 
point) expected. 
 
Values to include “,” in thousands  
 
This prompt asks that when you print values of 1000 that prints as 1,000.  If set then you need to 
manually increase the after decimal value of each numeric print item by 1 character for each 1000 
printed according to the maximum size of values. 
 
Space a Line between document entries  
 
Set to leave blank line between each entry printed. 
 
Final Document Totals 
 
Here you can set the printing position of the document total item Total Quantity x Cost.  As with 
line values you can enter the ‘before dec’, ‘after dec’ and ‘print dec’ values but in practice you are 
likely to position these items for print from the document mask. 
 
Order Header Items Printed 
 
This parameter screen allows you to nominate for print up to twenty items from the Works Order 
Header database.  In addition by setting the flag for Extra Header Items a further twenty items 
can be printed.  Additional parameter options include 
 
Use Item for Date  
 
This allows you to select a date data item from the Works Order Header database for use as the 
document print date. 
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Print Header Text  
 
On entry of the Works Order Header you can enter additional notes these can either be printed by 
nominating the individual data items for print anywhere in the header/footer area of the document 
or, by setting this option, printing within the detail area of the document.  If set then the additional 
notes/extra text are printed as the first x lines of description within the detail area. 
 
Omit Detail Lines  
 
Omits print/process of detail lines on the document.  Useful if wish to print a document for a great 
deal of header information. 
 
Edit Header Text  
 
If set then allows edit of the Additional Notes when printing the document. 
 
Stock Items Printed 
 
This parameter screen allows up to 15 items to be printed from the stock record of the 
finished/assembly stock item. 
 
Prompts: Request Information from Keyboard 
 
This allows you to define up to twelve free-format items for input and to print as part of the 
header or footer of the document.  These items can also be stored against the Works Order 
Header/Detail and Stock Transaction files (if set to update these files).  For example, you may 
wish to print a special message on certain documents.  The first six items you specify are 
prompted at the start of the document prior to the line entries; the last six are prompted at the end 
of the document after the line entries. 
 
For each prompt you wish to us key in the title such as “Deliver To”, and then key in the size (up 
to a max of 40) for the run-time response.  You can then set the line/column printing position 
although once the item is configured for prompt you can set this via F4-Select from the document 
mask.  Finally you can set data item numbers against the Works Order / Stock Transaction files to 
store the entered data against. 
 
Order Detail Items to be Printed 
 
This parameter screen allows you to print up to 10 nominated items from the order detail 
database.  If the item selected for print is a Table Item then options exist for printing the table 
description, rather than the value, and the length of the description. 
 
In addition you can select for print the order detail items to total, such as weight, for print within 
the document footer. 
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Finally the question Print Detail Text allows you to print the additional component notes, 
entered within the Works Order Detail entry, underneath the component description 
 
Order Detail Items to be Confirmed 
 
This parameter screen allows setting of two ‘confirm’ items.  These are data items on the Works 
Order Detail database that you would be allowed to amend after confirming the component 
quantity for issue. 
 
In addition you can define alternate items to display when processing the component details 
during document production. 
 
Optional Features During Printing/Updating 
 
Allow Fast OK of Order Header/Account Details  
 
When processing the document manually you are asked to confirm selected Order and Finished 
Stock details, you then asked to confirm details OK.  With this prompt set the last of these 
prompts is omitted. 
 
Force Updating of Files  
 
Set to Yes then once the details have been processed the operator is forced to update the file. 
 
Automatic Updating of Files  
 
If not set you are asked to Update the Order and Stock files (if updating both) individually.  If set 
you are asked to Update Files and both files are updated as appropriate.  Note if this question is 
set then you should not set the next option to omit changes to details as this is automatically 
suppressed for you. 
 
Omit Option to Change Any Details  
 
If not set (and automatic file update not set) then you are asked whether you wish to amend details 
after the document has been printed.  If set then this prompt is omitted. 
 
Always Accept Next Document No (no overtyping)  
 
The document number is displayed for confirmation/amendment after selecting the Works Order 
you wish to process.  If this prompt set then this reference cannot be amended. 
 
Use Document Number as Stock Reference  
 
Normally set, particularly if performing automatic updates, this uses the document number as the 
stock transaction reference. 
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Remember Previous Description on Stock Update  
 
If not updating files automatically then you are asked for the stock transaction description when 
updating the stock files.  This is normally entered during the Order Entry process but if not you 
can have the system offer the last description used, this session, for confirmation/amendment. 
 
Assemble more than one item per serial build  
 
If finished item and components are batch / serial tracked then you can only build one serial/batch 
item at a time to maintain traceability.  If set this option after printing the build document and 
updating the files the system will automatically loop back to reprocess the order until quantity is 
fully built. 
 
Re-calc Build Cost Using Latest Prices  
 
If set the system recopies the current cost price as the component cost for the works order details 
and uses this to accumulate the cost value of the finished item.  In not set then the cost price as at 
original order entry is used. 
 
Re-calc Sub Assemblies Using Current Stock Levels  
 
If exploding sub-assemblies only where there is insufficient stock then setting this option 
recalculates the build requirements of sub-assemblies based on current stock levels during the 
build process 
 
Special Print Options 
 
Force Printing of Document  
 
When set if you have confirmed the details are OK then you are forced to print the document. 
 
Omit any Print  
 
When set the document is not actually printed but the files continue to be updated.  This may be 
useful on a Build Document where you need to update the files but no printed confirmation is 
required. 
 
Force Page Out on Each Page  
 
Under some printer set-ups a document might not print until the job ‘times out’.  When set this 
option closes the print job after processing each page forcing the print of the document.  This is 
usually only required in Datafile systems on a Windows 95/98 peer-to-peer network using 
Datafile ‘DOS’ printer configurations. 
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Single Sheet Stationery  
 
When set before each page is printed the operator is asked to confirm the paper is inserted in the 
printer.  This is useful where a document is required to print on specific stationery that is not 
normally in the printer tray. 
 
Omit Printing of Any Order Details  
 
Set to omit print of details on a document.  This prompt is used to allow print of a Works Order 
Header when no details have yet been entered. 
 
Default Printing to Printer Number  
 
When printing a Datafile document/report the printer offered is usually the last printer used this 
session.  Here you can set a specific printer (configured in Datafile) to print this document to. 
 
Confirm at point of printing  
 
When processing a Works Order document the printer is usually selected at the start of the 
document process and all orders processed that session are printed to the selected printer.  When 
set this option asks for the printer at the point of responding to the ‘Print Document’ question and 
asks for each document. 
 
Automatic Print to Printer Number  
 
This option asks for the printer number to automatically print the document to (no user prompts). 
 
Number of Copies (1st Print)  
 
This option asks for the number of copies to print of the document.  This prompt is applicable 
even when not automatically printing the document. 
 
Automatic 2nd Print to Printer Number  
 
This option asks for the printer number to print a second copy of the document to.  This maybe 
useful where you wish to print a ‘customer’ copy on stationery and an ‘internal’ copy on plain 
paper. 
 
Number of Copies (2nd Print)  
 
This option asks for the number of copies of the 2nd print.  This prompt is only applicable if 
automatically printing a second copy. 
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Apply Authority Check for Re-Prints / Auth Level  
 
A document can be reprinted for a completed works order.  This option asks whether you wish to 
apply an authority level check for reprints of a completed works order and what the authority 
level required is.  Note that a document can be reprinted without limit whilst the order is active. 
 
Print Dates in DD/MM/YYYY format  
 
Transaction dates in Datafile allow entry of two characters for the year (26-99 being 1926 to 1999 
and 00-25 being 2000 to 2025).  If this is set the printed transaction date (from Document 
Headings) prints with a four-digit year. 
 
Copy Data Items between Files 
 
This parameter screen allows the setting of copy items to the Stock Transaction file from the 
Works Order Header, Works Order Detail and Stock Files.  10 copy items are allowed for each 
set. 
 
Selection Criteria / Auto Run Features 
 
Enter Search Criteria for Order Headers  
 
Usually used on automatic documents, though is also applicable for single documents, this option 
allows you to set selection criteria to restrict the orders processed. 
 
Allow User Changes to Criteria  
 
If set to allow criteria you may want to allow amendment of this criteria when the document is 
being processed, set this prompt to allow user changes. 
 
Always Write Back Current Criteria  
 
If set to allow criteria and to allow amendment of criteria at run-time then you may want to save 
these changes back for next time.  Set to allow this. 
 
The first three criteria questions relate to the Order Headers processed, the questions are then 
repeated for the Order Details processed. 
 
Auto Run (Hands Off) Printing Facility  
 
Set to ‘Y’ produces a document automatically for all orders subject to the quantity and selection 
criteria defaults. 
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Auto Run without Locking Files  
 
A ‘normal’ auto-run requires exclusive lock of the stock and works order databases, setting this 
prompt omits this requirement but does mean that if whilst processing an order a ‘lock’ isn’t 
possible then that order is omitted. 
 
Do Not Remember Doc-Date as System Date  
 
Within any one application the system ‘remembers’ input into transaction date inputs, so that if 
amend the date it remembers this for the next transaction date.  Setting this option prevents the 
document date being remembered. 
 
Only allow quantity if physically available  
 
When set this restricts the component quantity issued to that which is physically available on the 
stock item. 
 
If physical check, omit part quantities  
 
If the system cannot issue the full requirement of the component, because of insufficient stock, 
then none of the component is issued when this is set. 
 
If physical check, prompt to abandon  
 
When this option set if the system fails the physical check for a component the system will 
prompt to abandon the build process. 
 
Automatically Link to Another Document 
Link to Document (Print/Build) 
No 
Auto Mode 
 
If this document is a manually processed document (i.e. not an automatic run of several orders) 
then you can elect to automatically process another Bill of Materials document after this.   Set this 
option to allow the automatic link and then define the document type/number you wish to link to 
and whether the follow on document is to be processed automatically. 
 
Auto Accept Batches Input at Order Entry  
 
If pre-allocating batches during order entry you are still asked to confirm these details in the 
document.  If this set then provided the quantity processed are the same as originally entered then 
the pre-allocated batches are automatically accepted. 
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Continuation Options 
 
Continued Over Message 
Message printed on line/column 
Omit Footer Printing 
C/F Amount printed 
 
These questions enable you to specify the messages printed when a document is longer than one 
page.  First, key in the message you want to print, i.e. ‘Carried Forward’.  Then key the 
line/column the message is to print at (this is usually below the last detail line).  If printing cost 
values on the component detail then you can set a sub-total for each page by setting the C/F 
amount print position. 
 
The omit question refers to whether the detail you normally print at the footer of the page (below 
the last detail) are to be printed on all pages or just the last page.  Set this prompt to just print on 
the last page.  If omit footer printing then all text and data items below the detail (except for 
continuation message and value) are omitted, lines and boxes that start below the detail area are 
omitted but images continue to print. 
 
Following the footer/carried forward details a similar set of questions allow you settings for the 
header area when the document is longer than one page.  If omitting header printing then all text 
and data items above the detail (except for continuation message and value) are omitted, lines and 
boxes that start and finish above the detail area are omitted but images continue to print. 
 
Batch Tracking Printing (Header) 
 
If your finished item is batch tracked then you may want to print these batch details on the build 
note this parameter screen allows this. 
 
Print WOH Batches  
 
Set to allow print of batch details 
 
Start/End on Line  
 
This prompt asks which line to start and finish printing the batch details of the finished item. 
 
Quantity (Before, After, Decimal Point)  
 
This prompt asks for the column settings for the print of the batch quantity setting before (the start 
of the significant figures), after (the start of the decimal figures) and whether or not to print the 
decimal point. 
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Print Batch Item / Column  
 
These prompts allow selection of series of print items from the batch file and column setting for 
the item print. 
 
Max Across Page  
 
If building multiple batch/serial items you may wish to print the batch details across the page 
rather than down.  This option allows setting of the number of batch prints across the page. 
 
Repeat Col Offset  
 
If printing across the page this setting asks for the number of columns to add for the second and 
subsequent prints. 
 
Batch Tracking Printing (Detail) 
 
If any of the component details are batch/serial tracked then you may want to print these details 
on the build note.  Component batch details are printed in the detail area below the order detail 
they relate to. 
 
Print WOD Batches  
 
Set to allow print of batch details 
 
Space Line Before  
 
Set to allow line gap between last description line and the first batch/serial on print. 
 
Quantity (Before, After, Decimal Point)  
 
This prompt asks for the column settings for the print of the batch issue quantity. 
 
S/Ass Qty (Before, After, Decimal Point)  
 
This prompt asks for the column settings for the print of the batch build quantity when the 
component is a sub-assembly (this is usually the same as the issue quantity except where 
configured to issue available stock before build). 
 
Print Batch Item / Column  
 
These prompts allow selection of series of print items from the batch file and column setting for 
the item print. 
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Max Across Page  
 
If building multiple batch/serial items you may wish to print the batch details across the page 
rather than down.  This option allows setting of the number of batch prints across the page. 
 
Repeat Col Offset  
 
If printing across the page this setting asks for the number of columns to add for the second and 
subsequent prints. 
 
Customised Features (if implemented) 
 
Datafile Software Limited offers a service to add custom features for particular customer needs.  
Should you purchase any special feature there may be configuration settings that need to be 
applied to this screen.  For normal usage settings on this screen do not apply. 

Save and Exit 
 
The File pull-down allows you to save the document and exit the document design.  If you exit 
without saving you will be prompted to save the changes – if you respond ‘Yes’ then you save the 
document before exiting, if you respond ‘No’ then any changes you have made since the last save 
are abandoned. 
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Application User Facilities 
 
The Application User Facilities allow configuration of the individual Bill of Materials options. 
 

 

Enter / Amend Orders 
 
This option is used to define the way that the order entry procedures are to operate and provide 
several options of parameters and screen designs.  The options available are: 
 

 
Enter New Order Header 
 
This option allows you to modify the entry screen in which you first enter the order header 
information.  Most set-ups will want specific information here and you may well want to remove 
some of the items we offer on the standard set-up 
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Selecting this option gives you the screen layout to enter new orders.  For full details on the 
screen design processes see the Configuration Guide but in overview the key options are: 
 
 To enter text labels on the screen position the cursor where you wish to start and type in 

the details. 
 
 To draw a border line around the screen choose the ‘Tools’ pull-down on the toolbar and 

select the option ‘Border’ 
 
 To draw lines switch to ‘line mode’ by choosing the ‘Tools’ pull-down and select the 

option ‘line mode’.  When in line mode to draw a line you use the mouse to click the 
starting position and then drag the line to where you want it to finish (horizontal / vertical 
lines only).  Once all required lines are drawn you can switch back to ‘text mode’ by 
choose the ‘Tools’ pull-down again. 

 
 To display a data item then position the cursor where you wish to display the item and 

either right-click with the mouse or press <F4-Select>, a list of data items is then displayed 
for selection. 

 
Amend / View Order Header 
 
This option allows you to modify the entry screen used when amending or viewing the order 
header.  Although often the same display as the ‘Add’ screen, you have to option to have different 
information displayed. 
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Additional Order Detail Items to be Input 
 
If using detail pick mode for order entry (the default) or are using fast input or the system detail 
entry screen then you can nominate additional items to be displayed/input.  Up to thirteen items 
can be displayed although only the first eight would be available on detail pick / fast input entry 
modes. 
 

 
If using detail pick / fast input entry modes then the items set here do not appear by default but 
need to be enabled on the Fast Input Features parameter screen.  Similarly if using the 
‘designable’ detail entry screen then these items would need to be added to this screen.  
 
List Order Detail Items 
 
Not applicable in Detail Pick configuration (where list isn’t an option) this option allows you to 
select the data items to display from the component details when listing the detail records of the 
works order. 
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Alternate Order Header Status Line Display 
 
When entering the works order details a status line shows the order number, the number of 
entries, the total cost value so far and the finished stock item.  This option allows you to show 
different items and this option allows you to specify them. 
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You are asked if you wish to define your own set of items, if you do not select this option then the 
standard items are used.  If you do select then the set of items you subsequently define are used 
instead. 
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Optional Features / Instant Print / Fast Input Features 
 
Optional Features 
 

 
Allow Create New Stock/Product Record  
 
When set the operator can press <F7-Option on stock code inputs to create a new stock record. 
 
Auto F4-Sel on item if blank stock code  
 
This prompt asks for a data item number on the stock file (must also be set as a secondary index 
on the stock file).  When the operator leaves the stock code blank the system will then act as if the 
<Select> key had been pressed and ask for the search text against the nominated item.  Note: that 
if set then you should not use a blank stock code as the free-format identifier. 
 
Warn if less than physical/free stock  
 
This prompt asks whether you want the computer to warn if the order quantity would take the 
stock level below the current ‘free-stock’ quantity.  Free-Stock is normally calculated as Physical 
plus On-Order less Reserved quantities. 
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Excl On-Order in free-stock calculation  
 
If checking the order quantity against free-stock you may wish to exclude stock that is on-order 
from the free-stock value.  Note that if set it only excludes on-order from the stock check, the free 
stock calculation on the stock record still includes this value. 
 
Change Status: C-Complete when (0,1,2)  
 
This prompt asks when an order detail should be left as ‘C-Complete’ when using the change 
status option to change the status of the works order header.  Available responses are: 
 

0 When all built – if the order detail has been issued in full to the assembly then 
the status of the detail remains ‘C-Complete’. 

1 When any built – if the order detail has been partially issued to the assembly 
then the status of the detail remains ‘C-Complete’ 

2 Never – the order detail status flag is always updated as per the change of status 
entered regardless of its build status. 

 
Allow Free Format order details  
 
This prompt asks whether you wish to allow entry of order details for items not recorded on the 
stock file.  Set to allow entry of free format detail lines. 
 
Stock Code Value to signify free format  
 
Normally you leave this blank so that <Enter> on a blank stock code signifies a free-format line.  
Alternatively you may want to set a specific character(s) the operator must enter to add a free-
format line (FREE for example). 
 
Allow Description-Only Order Details  
 
Description only order details allow entry of notes and comments as works order details without 
the requirement to enter an order quantity (which free-format entry requires).  Set to allow entry 
of description only lines. 
 
Stock Code Value to signify desc-only  
 
Here you enter the ‘stock code’ to enter on an order detail to signify a free-format line.  As order 
details are created based on the components of an assembly we would recommend the use of ‘N’ 
for Notes as the description only identifier, this is consistent with the entry of notes in assembly 
maintenance. 
 
Allow Changes to the component costs  
 
When entering details the cost of that item is updated from the stock record.  This cost is normally 
set as view-only but if wish to make adjustments to the cost this parameter can be set. 
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Stock Quantity held in units (not price/per)  
 
Normally set, this means that where a stock item is held in packs a quantity of 1 represents 1 unit 
not 1 pack. 
 
Use Full Screen design for order detail  
 
Normally set to allow use and configuration of a ‘designable’ entry screen for components.  If not 
set a system screen is displayed when adding and amending details. 
 
Auto Allocation of Next Order Number  
 
Only applicable where the order reference format is numeric this option automatically sets the 
next order reference for you without the operator confirming it. 
 
Maintain Details in Pick Mode  
 
Pick display mode, which should be the default when using multi-level assemblies, allows the 
operator an alternative way of adding and amending.  Instead of allowing separate options for 
Adding, Updating, and Deleting the system has one option ‘Details’ which allows you to scroll up 
and down the details, amending, deleting and inserting as you go. 
 
Insert at Current Pick Line  
 
Applicable in detail pick mode when set this option allows you to insert a detail within the 
existing order details rather than at the end. 
 
If Pick Display, Toggle to Full Screen  
 
When amending the detail in pick display you are either in ‘fast’ mode where you enter only 
selected items, or ‘full’ mode where a full-screen is displayed.  This is controlled by whether ‘Use 
Full Screen Design for Order Detail’ is set.  If not set then you may still occasionally want to 
amend full details for an order detail – you can do this by setting this prompt.  When set then on 
add/amend of works order details you are nominally in ‘fast’ mode but can press <Page-Down> 
on the stock code to switch to ‘full’ mode. 
 
Show Extra Account Items when adding  
 
Each works order can be linked to a sales account.  When select an account the name and address 
details are displayed for you to confirm.  When you set this item you can nominate an additional 
five items which are also displayed here. 
 
Change Status Ask Separately for Details  
 
When manually change the status of an order (active-to-complete for example) then the change in 
status is automatically applied to the works order details.  When set this enables you to confirm 
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whether the status change of the works order header is to be applied to the details – this option 
would normally not be set. 
 
Lock Required Stock After Data Entry  
 
When updating the order header the system places a U-Usage lock on the stock records on any 
existing works order details as the system may need to update these records depending on the 
amendment made.  If any of the Stock Records are exclusively locked then changes to options 
such as the ‘reserved’ / ‘credit’ flag or the finished goods order quantity are not allowed.  This 
option omits these locks, allowing change of these values, until the order header is updated – if 
the system successfully places the locks then the changes are updated, if the locks aren’t placed 
then the changes are rejected. 
 
Instant Print 
 
This set of parameters determines whether or not you can invoke a document printing process 
immediately you have entered an order.  The options you can define include which type of 
document you can print, for which order status settings you can print, which document and 
whether the print is to be automatic. 
 

 
There are two document types in Bill of Materials, a Print Works Order type (PRT) and a Build 
Works Order (BLD).  Next to each type are three status types - Active, Forward and Hold 
(although only Active is applicable for the Build).  You set whether a document can be printed for 
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that document type/status by setting the ‘allow’ prompt, you can then choose which document is 
printed by nominating 1 to 6 (or 0 to allow run-time selection) and then set ‘Auto’ according to 
whether you wish to print the document without user intervention. 
 
Fast Input Features 
 

 
The final Optional Features screen defines the items displayed in the Fast Input / Detail Pick style 
of order input.  
 
Fast Input by Line Required  
 
Set to allow use this feature at run-time (normally set) 
 
Prompt for another entry  
 
Set to allow the system to prompt after saving each detail whether you want to add another.  This 
would normally not be set and the system automatically adds another detail and you press <END> 
on a blank stock to complete order detail entry. 
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Maximum Size for Values  
 
The fast input / detail pick style of inputs are fixed to a maximum number of character inputs per 
line.  This option allows you to restrict the space allowed for entering values to a set number of 
significant figures – e.g. a setting of 5 allows a maximum value of 99999.99. 
 
Items Allowed  
 
Next is a series of nine pre-selected items which can be displayed, we would normally suggest a 
minimum of Stock, Description and Quantity are required for Bill of Materials.  Following the 
pre-selected items you can also nominate whether any or the set additional order detail items are 
to be input in fast input. 
 
Ask Description at bottom of screen  
 
The component description is likely to be the largest item input and, bearing in mind the character 
limit above, will take up a considerable amount of this space.  As an alternative the description 
can be prompted as a pop-up at the bottom of the screen. 
 
Or Truncate Description display on line  
 
As an alternate the description can be truncated so that it only displays (when not being edited) to 
a set number of characters. 
 
Create New Stock Record 
 
This option allows you to modify the Stock maintenance screen used when creating stock records 
within Bill of Materials.   
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To design the screen: 
 
 To enter text labels on the screen position the cursor where you wish to start and type in 

the details. 
 
 To draw a border line around the screen choose the ‘Tools’ pull-down on the toolbar and 

select the option ‘Border’ 
 
 To draw lines switch to ‘line mode’ by choosing the ‘Tools’ pull-down and select the 

option ‘line mode’.  When in line mode to draw a line you use the mouse to click the 
starting position and then drag the line to where you want it to finish (horizontal / vertical 
lines only).  Once all required lines are drawn you can switch back to ‘text mode’ by 
choose the ‘Tools’ pull-down again. 

 
 To display a data item then position the cursor where you wish to display the item and 

either right-click with the mouse or press <F4-Select>, a list of data items is then displayed 
for selection. 

 
Maintain Order Details 
 
If using the ‘full screen design’ for order details as set within the Optional Features this option 
allows you to modify the detail input screen. 
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You design the screen as per notes above. 
 
Generate from Sales Orders 
 
This parameter screen allows you to define whether works orders can be created from sales 
orders. 
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Generate Works Orders from Sales  
 
Set to allow generation of works orders from sales orders entered for assembly items. 
 
Check all SOD records for Works Order flag  
 
By default the system only checks for sales orders that have been flagged from the first ‘active’ 
order.  However if reactivating very early sales orders and flagging these they would not be 
picked up normally, setting this option the system reads the full sales order detail file for any sales 
orders requiring works order generation. 
 
Create Works Order if Sales Order on Hold  
 
If a Sales Order has been placed on hold, perhaps for credit reasons, do you still want to create the 
works order or wait until it is changed to active. 
 
Always Build multiple of Assembly Quantity  
 
Depending on the business you may be configuring assemblies to build multiple units of an item 
for economies of scale.  If so then this question asks whether the system should ‘round up’ the 
works order quantity on works orders generated from sales to a multiple of this assembly 
quantity. 
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Specify any Copy Items  
 
When set a pop-up screen allows a series of ten copy items from the Sales Order Header to Works 
Order Header, Sales Order Detail to Works Order Header and from Works Order Header back to 
the Sales Order Detail.  All copy items actioned at the point of works order generation. 
 
Use pre-allocated SOD batches/serials in WOH  
 
If using batch tracking then SOP can be configured to allow entry of batch/serial numbers to be 
issued during order entry.  Normally, when building an assembly the serial number for the 
finished item will be set by you so this option, if enabled, allows for the generation of the new 
serial item numbers on sales order entry and transfers these to the works order.  Alternatively, the 
serial numbers are generated within Bill of Materials and then become available for issue on the 
SOP Delivery Note. 

Print Works Orders 
 
This option puts you into the document design procedure to allow you to define up to six different 
document layouts.  The document design process is common across all Datafile Software 
modules, and is fully described within the Document Design Manager section of the 
Configuration Guide. 
 
The parameters behind the documents, which are specific to Bill of Materials, are discussed in the 
Document Design section of this manual. 

Print Stock Picking Sheets 
 
This option allows you to configure the Stock Picking Sheet report and the consolidated picking 
sheet reports. 
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The Stock Picking Sheet provides a list of components for active works order details that can be 
given to the warehouse so that components can be pulled from the shelves in preparation for 
building.   This option allows you to define the items that appear on this report and these items 
also apply for the consolidated picking sheets. 
 
Print Control  
 
This setting controls the page size when the OPTIONS parameters are not enabled.  Up to eight 
report styles may have defined on your system (through CONFIG user).  These control the length 
and width of the page of your report.  Select the style appropriate for this report, the available 
styles being displayed in a help ‘bubble’ at the foot of the screen. 
 
Data Items  
 
Up to ten data items from the detail file can be printed across the page from the Works Order 
Detail file for this report.  The items are listed in the Data Items list on the right or you can select 
the data item by using the <Select> key. 
 
Sorting Sequence  
 
This report usually prints in the sequence the details were added, you may specify a different 
sequence for the report here by selecting the data items to sort on.  As part of the sort sequence 
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you also set whether it is to be applied in Ascending or Descending order.  Note that if using the 
consolidated picking sheet reports then the sort sequence at run-time is pre-sorted by stock code. 
 
The OPTIONS Button  
 
Selecting the OPTIONS button allows access to the print configuration (margins / page size / 
fonts) 
 

 
The layout of this screen differs slightly based on whether you have set the page size (as above) or 
not.  Before discussing the parameters you should note the buttons available at the footer of this 
parameter screen. 
 
Default - This option updates the individual parameters from your user default when they are set, 
overwriting presets where applicable.  If no user defaults are set then this option is ‘greyed’ out.  
To set user defaults see the appropriate section below. 
 
Save - This saves your set parameters so they are offered as default next time this report is run  
 
Abandon - This option abandons any changes made and returns you to the report screen. 
 
The report parameters available are: 
 
 Paper Size – select the paper size the report is to be printed to (i.e. A4).  You can elect to 

leave this blank in which case the report is printed as per the last/default page size of the 
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printer, however, if you do this you can only choose fixed pitch fonts – selecting a page 
size is mandatory to use proportional fonts. If you set a page size then the options screen 
re-displays with the appropriate parameters.  If you leave blank then the options screen 
remains as above. 

 
 Default Printer Font – a font dialog is display allowing you to select as required, the 

default font to be used for this report.  If you’ve sent the page size then all fonts are 
available, if you haven’t set this then only fixed pitch fonts can be assigned.  You can also 
set bold/italic attributes and font size – note that if you haven’t set a page size then the font 
size option is not applicable (font is sized as per previous rules). 

 
 

Selecting the Font Size 
 

Generally you can’t go far wrong with 10point.  However, if you have a lot of data 
items on your report, and are printing in portrait, 10point may be too big to fit all the 
required information without overlapping fields. 
 
The positioning of fields across the page is determined by the item size – if you 
imagine the Order Status listing report this shows, by default, the order reference (10 
characters), the status (6 – as field name is larger than field size), the date added (8), 
the assembly number (10), the stock code (16), the customer reference (15), and the 
date required (8), together with spaces between the items this gives a total of 104 
characters, or columns required, across the page (think graph paper – you have 104 
‘cells’ across the page). 
 
Those 104 columns are split equally across the available page (page size and margins 
taken into account) as starting positions for data items – so the order reference starts 
at column 1, the status at column 12 (order reference plus 1), etc.  If you select a font 
size too big then the order reference may not finish printing before the status starts 
causing the status to overlap the end of the order reference.  If this occurs then you 
may need to either reduce the font size or consider swapping the report to landscape 
orientation if the font size would go too small. 
 

 
 Default to Landscape – set to default the printed report to landscape, leave blank for 

usual portrait orientation.  You may want to set reports such as the Sales Ledger Aged 
Debtors Report or the Cashbook Receipts Analysis Listing to landscape as these reports 
require a large amount of detail to be printed and otherwise the font size could be too 
small. 

 
 Show Time in Report Headings – set to include the printed time in the report headings in 

addition to the printed date. 
 
 Include Selection Criteria – set to print any selection criteria that were applied to the 

report. 
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 Email as Text – if send this report via email this option allows you to send as a text file 
attachment as opposed to, if left blank, PDF. 

 
 Omit Full Page Headings – When printing a multi-page report the system repeats the 

headings for each page.  Setting this option reduces the heading details for the second and 
subsequent pages allowing more record detail to be printed per page. 

 
 Default Output to Spooler – Usually, when printing a report, the default printer is the last 

print device used.  Select this option to set the default printer as the spooler for this report.  
This acts only as a default and doesn’t prevent you electing to print the report instead. 

 
 Allow Change of Printer Alias – when these options are configured then it is assumed 

you are printing as ‘direct windows print’ and this is the alias set by default.  Setting this 
option allows you to change the default alias at run-time to one of the list of Datafile 
configured printers.  If you change the alias to a ‘DOS’ style alias then the page size 
(length/width) and font are again picked up from the Print Style Profile, although other 
settings such as ‘include time’ etc. remain from the OPTIONS display. 

 
 Print Negatives in Red – on selected reports, assuming you have a colour printer, it may 

be useful to print negative values in red. This option allows this. 
 
The next set of parameters allows you to specify formatting and margin settings.  This section is 
different if you set the page size earlier.  If you have set the page size then you set the margins in 
millimetres.  If you haven’t set the page size then you set margin in ‘columns’ for both portrait 
and landscape - the appropriate settings being used based on the orientation of the output selected 
at run-time.   
 
Paper Size Set 
 
 Characters Per Line – the system displays the width of the report items on the right.  If 

you leave this value at 0 (recommended) then the report width used in determining the start 
column positions of data items (as discussed above with regards to font size) is the larger 
of either the report print items or 80 columns.  You can manually set a report width – from 
64 to 255 columns.  You may want to increase the number of columns on (say) a landscape 
report with few print items to bring the fields closer together to aid in reading. 

 
 Lines Per Page – if left at 0 (recommended) then the number of lines per page is 

determined by the font and page size.  Alternatively you can set a number of lines per 
page, perhaps to give a greater gap between rows of data items. 

 
 Left Margin (mm) – set the size of the left hand margin (relative to page orientation in 

millimetres. 
 
 Right Margin (mm) – set the size of the right hand margin. 
 
 Top Margin (mm) – set the size of the top margin. 
 
 Bottom Margin (mm) – set the size of the bottom margin. 



112  Bill of Materials 

Datafile Bill of Materials 
12/02/2007 

 
Paper Size Not Set 
 
 Minimum Characters Per Line – the system displays the width of the report items to the 

right.  If you leave this value as 0 then the report width is the larger of either the report 
print items or 80 characters.  You can manually set a report width – from 64 to 255 
characters wide – but if you set a width less than the items actually printed then this is 
overridden by the report width at run-time. 

 
 Maximum Lines Per Page – if left at 0 then when printing a report the system will 

determine the number of lines per page based on the report width and the printable area of 
the page up to a maximum of 72 lines per page in portrait mode or 50 lines per page in 
landscape mode.  Alternatively you can set the number of lines per page, from 16 to 255, 
and this is then taken into account when deciding font size to ensure that number of lines is 
printed.  If left at 0 then when sending to the spooler the lines per page is assumed to be 72 
in portrait mode and 50 in landscape.  If you require an identical print from the printer and 
the spooler then a maximum number of lines should be set. 

 
 Left Margin – set the number of characters to be used as a margin from 1 to 64.  If you 

require a margin then when entering the value you need to take into account the report 
print width – a margin of 4 characters on an 80-character report will be bigger than a 
margin of 4 characters on a 132-character report.  If left at 0 no left margin is applied. 

 
 Right Margin – if you require a margin to be applied on the right of the report set the 

number of characters accordingly (again 1-64), if leave as 0 then no right margin is 
applied. 

 
 Top Margin – set the number of lines to leave as a margin at the top of the page (1-32 

lines).  If left at 0 then no top margin is applied. 
 
 Bottom Margin – set the number of lines to leave as a margin at the bottom of the page 

(1-32 lines).  If left at 0 then no bottom margin is applied. 
 
Finally, you can set default options that are used when you send the report to print or e-mail. 
 
 Print Device – if using a stand-alone Datafile system then you can set a default printer to 

output to.  This option only applies when sending to a print device; if last printer was 
spooler or fax then this remains the default.  If using a networked Datafile system then you 
can still set this where you are printing to a networked printer – provided all terminals have 
a consistent device path.  If the print device isn’t valid then the normal printer is offered 
instead. 

 
 E-mail Address – if the report is sent to email then here you can enter an email address 

that is to be used by default for this report – though it can be amended at run-time. 
 
Once you’ve set the desired parameters select the SAVE option to apply for future prints. 
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After setting the detail print items a second screen allows you to set the header printer items for 
use on the ‘Consolidated Picking Sheet (by Order)’ report.  Here you can specify up to ten items 
from the Order Header file to print (first five on left, second five on the right) and then the sort 
sequence for the report. 
 

 

Build Works Orders 
 
As with the ‘Print Works Order’ this option allows you to design up to six different build 
document layouts.  The parameters behind the document are discussed in the Document Design 
section of this manual. 

Reports and Analyses 
 
Here you define how the standard Bill of Materials reports are to print.  As with the Stock Picking 
Sheet you can select the print control, the data items to print, the sorting sequence and the options 
parameters. 
 
Order Status Listing  
 
This report prints from the Works Order Header file, and up to twelve items can be listed. 
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Order Specification  
 
This report prints ten items from the Works Order Header in two columns of five items, followed 
by the list of detail items making up the order.  You specify the order header items and the sort 
sequence first then a second page allows you to select up to ten items to list across the page for 
each detail line.  In addition for multi-level assembly details the option exists to indent by a set 
number of characters the stock code for each assembly level. 
 
Outstanding Orders  
 
This report prints from the Works Order Detail file; up to twelve items can be listed.  Only details 
that have not been fully built are reported. 
 
Order Listing  
 
This report prints from the Works Order Header file and up to twelve items can be listed. 
 
Detail Listing  
 
This report prints from the Works Order Detail file and up to twelve items can be listed. 
 
Order Analysis  
 
This report has a fixed format and you are only prompted for the printer profile.  When the report 
is printed it analyses the orders and their values by status (active, completed, forward, etc.) 

Remove Redundant Orders 
 
There is only one parameter to set for this option.  You may specify a suffix which ensures that 
orders whose reference match this suffix are not deleted when using the cleardown options at run-
time.  For example, if your order reference format was 99999/AA and you wanted to retain 
engineering orders identifiable by the suffixed EX, then enter EN here and these would be 
retained. In practice with most order reference sequences being purely numeric this option is not 
applicable. 
 



Configuring Bill of Materials  115 

Datafile Bill of Materials 
12/02/2007 

 

Order Enquiry 
 
When bringing an order enquiry to the screen up to nine items from the order header are shown in 
two columns, plus up to ten items from each order detail record across the screen. Here you select 
the data items from each file that you wish to display.  Use the <Select> key to help you choose 
the data items from the file. 
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System Status 
 
This screen is for information only and lists the items shown when the system status display is 
selected within the user program. 
 

Application Screen Layouts 
 
This option allows access to the ‘Enter / Amend Orders’ section of the Application User Facilities 
to allow configuration of the entry screens for Bill of Materials – refer to this section for further 
details. 
 

Select Key Definition 
 
Whenever you press <F4-Select> within the Bill of Materials system the details displayed can be 
configured as required this is done within the select key definition. 
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As you select this option the system displays each of the application databases used within Bill of 
Materials asking, in turn, you to select up to ten items from that database for display when you 
press <F4-Select>.  In addition you can select whether, when listed, these details are listed in 
LIFO order or a pre-defined sequence. 
 
Note: these items only affect the items displayed in the list when selected within Bill of Materials; 
they do not affect the items you can filter on (i.e. the header selection inputs).  These are the 
prime and secondary indexes of the databases concerned. 
 

Recall Standard Text 
 
Recall Standard Text allows you to attach a word or phrase to a specific key combination (such as 
<Shift>+<F1>).  For example you might want the additional notes to include the phrase ‘Build to 
Standard Specification’ when no amendments are required.  Up to fifteen phrases can be entered 
and these are updated when inputting into a text field within Bill of Materials when you press the 
applicable key combination. 
 
Note that the key combinations used are defined within the CONFIG user-id parameters. 
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Set Database Profiles 
 
Database Profiles are the interface between the program and the databases, allowing the program 
to read/update the data and interpret the values contained within.  The data item profiles for Bill 
of Materials are detailed below. 
 
Header Mandatory 
 
Data Item Type Notes 
 
ORDER-CODE X (16) Holds the Order Reference for the works order 
ORDER-STATUS X (1) Holds the order status 
DATE-ENTERED D, E Holds the date the order was added 
DATE-AMENDED D, E Holds the date the order was last amended 
DATE-PRINTED D, E Holds the date the last Works Order acknowledgement 

was printed. 
DATE-BUILD D, E Holds the date the last Build document was printed. 
ASSEMBLY-CODE X (16) Holds the assembly code of the finished stock item 

being built. 
STOCK-CODE X (16) Holds the stock code of the item being built 
ORDER-QTY K, L, M Holds the ordered qty of the finished item 
BUILD-QTY K, L, M Holds the build qty of the finished item (usually the 

same as order qty but when using non-unit build 
quantities or wastage-% on an assembly then may be 
different) 

BUILD-WASTAGE-% K, L Holds the wastage factor of the assembled item. 
NO-OF-ENTRIES N Holds the number of details on this works order. 
FIRST-DETAIL Y (6) Holds the record number of the first works order detail 

for this order. 
LAST-DETAIL Y (6) Holds the record number of the last works order detail 

for this order. 
 
Header Optional 1 
 
Data Item Type Notes 
 
PRINT-REF X (6) Holds the document reference of the last Works Order 

Acknowledgement printed. 
BUILD-REF X (6) Holds the document reference of the last build note 

printed. 
STOCK-DESCRIPTION X (30) Holds the transaction description to be written to Stock 

for the build. 
RESERVE-STOCK ? Flag to identify whether component stock was reserved 

for this works order. 
COST-VALUE K, L, M Holds the accumulated cost value of the order details. 
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ACCOUNT-CODE X (10) Holds the customer a/c code the works order is to be 
supplied to. 

CUSTOMER-REF X (16) Holds a reference given by the customer for the works 
order. 

DATE-REQUIRED D, E Holds the date the completion of the works order is 
required by. 

FIRST-BATCH-ITEM X (30) Holds the batch/serial number of the finished stock that 
is being built when pre-allocating batch details.  The 
next (x) number of consecutive items in the database 
must also be batch-item fields.  The number of items 
determined by settings in the Batch Tracking System 
Profiles. 

FIRST-BATCH-QTY K, L, M Holds the qty of the first batch/serial of the finished 
stock that is being built.  As with the batch-item the 
next (x) consecutive items in the database must also be 
batch qty fields. 

 
Header Optional 2 
 
Data Item Type Notes 
 
IS-THIS-A-CREDIT ? Flag item that holds whether the works order is a credit 

order or not. 
EXTRA-TEXT-FIRST X (30) Holds the first line of additional notes that can be 

recorded against the works order header. 
EXTRA-TEXT-LAST X (30) Holds the last line of additional notes.  All items 

between this and the previous input are assumed to be 
inputs for additional notes. 

ASSEMBLY-NOTES X (30) Holds the notes recorded against the assembly 
definition for the finished item. 

MEMO-REFERENCE Y (6) Holds the reference number of any text memo that may 
be attached to the works order. 

BATCH-COMPONENTS N Holds the number of works order details for 
batch/serial tracked items. 

ASSEMBLY-EXTRA  In assembly maintenance you are able to define input 
of an extra item.  If set then this can be transferred into 
the works order in the data item referenced here. 

QUANTITY-BUILT K, L, M Holds the quantity of the finished item built so far. 
LAST-QTY-BUILT K, L, M Holds the last quantity built on the works order. 
CREDIT-QUANTITY K, L, M Holds the credit (de-kit) quantity processed on the 

works order 
WRITE-OFF-QTY K, L, M Holds the quantity abandoned from being built on the 

works order. 
USER-ACCUM-1 K, L, M Holds the total accumulated from the works order 

detail for the first nominated accumulation item. 
USER-ACCUM-2 K, L, M Holds the total accumulated from the works order 

detail for the second nominated item. 
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USER-ACCUM-3 K, L, M Holds the total accumulated from the works order 
detail for the third nominated item. 

 
Header Optional 3 
 
Data Item Type Notes 
 
SALES-ORDER-FLAG X (1) Holds flag identifying whether the works order was 

created from a sales order. 
SALES-ORDER-REF X (16) Holds the sales order reference the works order was 

created from. 
SALES-ORDER-ENT N Holds the sales order detail entry number the works 

order was created from. 
 
Detail Mandatory 
 
Data Item Type Notes 
 
ORDER-CODE X (16) Holds the order reference for the works order 
ENTRY-NUMBER N Holds the entry number within the works order for the 

detail. 
DETAIL-STATUS X (1) Holds the status (active, complete) of the works order 

detail 
NEXT-DETAIL Y (6) Holds the record number of the next detail for this 

works order. 
STOCK-CODE X (16) Holds the component stock code. 
ORDER-QUANTITY K, L, M Holds the quantity required of the component 
BUILD-QUANTITY K, L, M Holds the quantity required of the component for the 

build (adjustment of the order quantity based on an 
wastage settings). 

BUILD-WASTAGE-% K, L, M Holds the percentage wastage required according to 
assembly settings where the stock item is flagged as 
applying wastage. 

STOCK-WASTAGE-% K, L, M Holds the wastage of the component recorded against 
it’s stock record. 

COST-PRICE K, L, M Holds the unit cost of the component item. 
ORDER-RECORD-NO Y (6) Holds the record number of the Works Order Header 

record. 
DETAIL-COST K, L, M Holds the total cost of the works order detail 
WORK-QTY K, L, M Internal quantity used in document processing 
WORRK-QTY (SUB-ASS) K, L, M Internal quantity used in document processing 
 
Detail Optional 1 
 
Data Item Type Notes 
 
DATE-ENTERED D, E Holds the date the detail was added 
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DATE-AMENDED D, E Holds the date the detail was last amended 
DATE-PRINTED D, E Holds the date the detail was last printed 
DATE-BUILT D, E Holds the date the detail was built 
PRINT-REF X (6) Holds the reference of the last works order 

acknowledgement printed. 
BUILD-REF X (6) Holds the reference of the last build note printed. 
LAST-BUILD-QTY K, L, M Holds the last quantity built of this detail 
COLUMN-1-ENTRY X Holds the first additional detail input. 
COLUMN-2-ENTRY X Holds the second additional detail input. 
IS-THIS-A-CREDIT ? Flag to identify whether works order is a credit or not. 
 
Detail Optional 2 
 
Data Item Type  Notes 
 
DESCRIPTION-1 X (30) Holds the first line of stock description for this 

component. 
DESCRIPTION-2 X (30) Holds the second line of stock description for this 

component. 
DESCRIPTION-ONLY ? Flag to identify order detail as containing description 

detail only. 
QUANTITY-BUILT K, L, M Holds the quantity built of the component 
PACK-QUANTITY N Holds the pack quantity of the component 
SPLIT-QUANTITY M If stock item held in pack this holds the number of units 

taken from a split pack. 
WORK-QTY-PACK K, L, M Internal quantity used in document processing. 
PRICE-PER-FACTOR N Holds the price per unit quantity held on the stock 

record. 
COST-PER-FACTOR N Holds the cost per unit quantity held on the stock 

record. 
EXTRA-TEXT-FIRST X (30) Holds the first line of the additional notes recorded on 

the works order detail 
EXTRA-TEXT-LAST X (30) Holds the last line of the additional notes recorded on 

the works order detail.  The data items between these 
two references are assumed to be additional notes as 
well. 

COMPONENT-NOTES X (30) Holds the component notes recorded for this 
component in the assembly definition. 

PACK-MULT N, K Holds the pack multiplication factor when stock held in 
packs. 

 
Detail Optional 3 
 
Data Item Type Notes 
 
ACCOUNT-CODE X (10) Holds the customer account the works order is placed 

for. 
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CREDIT-QTY K, L, M Holds the quantity credited against this works order. 
WRITE-OFF-QTY K, L, M Holds the quantity abandoned against this works order. 
USER-ACCUM-1 K, L, M, * Holds the item number of the first value to be 

accumulated to the works order header. 
USER-ACCUM-2 K, L, M, * Holds the item number of the second value to be 

accumulated to the works order header 
USER-ACCUM-3 K, L, M, * Holds the item number of the third value to be 

accumulated to the works order header. 
FIRST-BATCH-ITEM X (30) Holds the first batch code pre-allocated for issue on this 

component.  The next x data items will also hold batch 
codes for issue on this component (x is set as the 
maximum number that can be issued in Batch Tracking 
System Profiles) 

FIRST-BATCH-QTY K, L, M Holds the quantity of the first batch to be issued for this 
component.  Again the next x data items will hold 
batch quantities. 

 
Detail Optional 4 
 
Data Item Type Notes 
 
ASSEMBLY-LEVEL N Holds the assembly level of the works order detail.  

The main components are level 1, sub-assembly 
components level 2 and so on. 

SUB-ASSEMBLY ? Flag to identify works order detail as being for a sub-
assembly. 

SUB-ASSEMBLY-CODE X (16) Holds the assembly code of the sub-assembly 
SUB-ASSEMBLY-COST K, L, M Holds the total cost value of the sub-assembly 
SUB-ASS-ORDER-QTY K, L, M Holds the order quantity of the sub-assembly that is to 

be built (may be less than the order quantity when 
some of the sub-assembly stock item already in stock). 

SUB-ASS-BUILD-QTY K, L, M Holds the quantity of the sub-assembly that has been 
built. 

COMPONENTS-CHG ? Flag to identify that sub-assembly components have 
been modified from standard assembly structure. 

BUILD-FACTOR M Holds the number of units of a sub-assembly 
component required to build one of the finished item. 

 
Copy Item Facilities 
 
Copy Items allow you to copy information from a record in one database to another where a link 
between the two databases exists.  There are various copy item options in Bill of Materials, these 
are: 
 
Copy Account to Header Two screens of copy items (twenty copy items 

altogether) from the Sales Account to the Works Order 
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Header.  These copy items are actioned when a works 
order is linked to a specific customer. 

 
Copy Stock to Header Two screens of copy items (twenty copy items 

altogether) from the Stock Record of the finished item 
to the Works Order Header.  These copy items are 
actioned when a works order is added. 

 
Copy Stock to Detail Two screens of copy items (twenty copy items 

altogether) from the Stock Record of the component 
item to the Works Order Detail.  These copy items are 
actioned when a works order detail is added or 
amended and the stock code is changed. 

 
Copy Header to Detail Two screens of copy items (twenty copy items 

altogether) from the Works Order Header to Detail.  
These copy items are actioned when a detail is added 
and the header is updated during data entry. 

 
Copy Stock UPD Detail One screen of copy items (ten altogether) from the 

Stock file to the Works Order Detail.  These are 
actioned when an order detail is added or amended, in 
addition if set in System Profiles they will also be 
actioned when a build document is processed. 

 
Copy Detail UPD Stock One screen of copy items (ten altogether) from the 

Works Order Detail file to the Stock file.  These are 
actioned when an order detail is added or amended, in 
addition if set in System Profiles they will also be 
actioned when a build document is processed. 
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